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Export and Production GuideExport and Production Guide
The Export and Production Guide provides administrators and case end users of the Veritas E-
Discovery Platform with details on how to prepare, export, or produce data in the application. 
This guide also provides details on various file types and hidden content, and describes tasks, 
best practices, and troubleshooting techniques associated with advanced export and 
production. 

This section contains the following sections:

• “About This Guide” in the next section

• “Revision History” on page 6

• “Technical Support” on page 8

• “Documentation” on page 8

• “Documentation Feedback” on page 8

About This Guide
As a supplement for case administrators, and a companion to the Case Administration Guide, 
the Export and Production Guide is intended to help you understand the export and production 
features in greater detail. It also describes best practices for performing exports and 
productions. 

Note: You must have appropriate user permissions to perform advanced exports and 
production tasks. Check with your eDiscovery administrator for more information. 

Related Documents
Refer the following documents for additional information related to Export and Production:

• Veritas eDiscovery Platform New Features Overview

• Veritas eDiscovery Platform Case Administration Guide
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Revision History

The following table lists the information that has been revised or added since the initial release 
of this document. The table also lists the revision date for these changes.

Revision Date New Information

March 2020 • Removed RMS option to export in decrypted format

• Minor edits

October 2018 • Added information for Privilege and Redaction logs. See “Logs” on page 93.

• Minor edits

March 2018 • Minor edits

June 2017 • Minor edits

July 2016 • Re-branding changes

August 2015 • Designate custom export location: metadata/production/native-only

• Removed Rights Management Guide

March 2015 • Image accessibility

• Added Reporting Section

• New Production Membership Report

• Branding and minor edits

October 2014 • Check box to export email headers

• Item level support for Production exports

• New user interface options for Metadata and Production export

• Newly designed export template format

• New export options with tag and folder selections 

• Branding edits and updated screenshots

• RMS option to export in decrypted format

• Added slip sheet report worksheets (top level and item level)

• Export Native View PST File Options drop down has been removed

• View production slip report through Analysis & Review module

December 2013 • Minor edits

June 2013 • Export audit reports

• Ability to modify non-system export templates

• Release template updates and edits

• Bcc/DL EV Journal metadata and production selections added - applies to EV 
10.0.2 and later versions

• Email header search (locator hit) exports

• Tagging enhancements & removal of Propagate tags to attachments & 
embedding option

• Deprecated production premediation. This feature is replaced with image 
remediation which is more comprehensive and tightly integrated with the 
product. For more information, see "Image Remediation" in the Case 
Administration Guide.
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September 2012 • Slip sheet improvements

• Release template updates and edits

March 2012 • If the export XML output is too large for one file, you can request that export 
divide up the output based on the number of documents. Previously, if 
export needed to split the XML output, it was based on file size (MB). 

• When retrying an export job, the documents are copied into the original 
export folders instead of creating new retry subfolders following a text or 
native naming convention.

• When “include native” is selected and the source files are NSF, the NSF output 
is put in a folder shared across all the rolled over XML files. The NSF files are 
not separated into an XML specific native folder.

• Minor updates, edits and format changes throughout.

Feb 2012 • Branding and minor formatting changes only

Nov 2011 • New top menu navigation, and enhanced Metadata and Production export 
workflow including new tabbed options 

• Create, save, apply export templates 

• Other minor updates throughout

May 2011 • Integrated Export Troubleshooting Guide content and merged in Advanced 
Export section (removed) from Case Administration guide

• Added other minor related export and production content, including the fol-
lowing features:

– Production Premediation support feature

– Production Slip Sheet Reporting 

Feb 2011 (and prior) • Export Troubleshooting Guide (Release Independent)

Revision Date New Information
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Technical Support
Technical Support maintains support centers globally. All support services will be delivered in 
accordance with your support agreement and the then-current enterprise technical support 
policies.

For information about our support offerings and how to contact Technical Support, visit our 
website:

https://www.veritas.com/support

You can manage your Veritas account information at the following URL:

https://my.veritas.com

If you have questions regarding an existing support agreement, please email the support 
agreement administration team for your region as follows:

Documentation
Make sure that you have the current version of the documentation. The latest documentation is 
available from:

• Documentation link at the bottom of any page in the Veritas E-Discovery Platform landing 
page.

• Veritas Technologies LLC. All rights reserved. Products Web site: https://
www.veritas.com/product/a-to-z

Documentation Feedback
Your feedback is important to us. Suggest improvements or report errors or omissions to the 
documentation. Include the document title, document version, chapter title, and section title of 
the text on which you are reporting. Send feedback to:

eDiscovery.InfoDev@veritas.com

You can also see documentation information or ask a question on the Veritas community site.

https://vox.veritas.com/

Worldwide (except Japan) CustomerCare@veritas.com

Japan CustomerCare_Japan@veritas.com

mailto: CustomerCare@veritas.com
mailto: CustomerCare_Japan@veritas.com
https://www.veritas.com/support
https://my.veritas.com
https://www.veritas.com/product/a-to-z
https://www.veritas.com/product/a-to-z
https://vox.veritas.com/
https://www.veritas.com/product/a-to-z
https://www.veritas.com/product/a-to-z
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Export and Production GuideOverview
Exporting and producing data in the eDiscovery Platform can be greatly simplified when you 
take certain precautions and plan ahead for the results you want to achieve. Depending on your 
export or production output requirements, the application provides various configuration and 
project management options to help you prepare and run your jobs successfully. 

This guide describes each export and production type and the differences between them, 
including what potential issues and outcomes to consider before export or production, and 
how to perform the tasks necessary to successfully export and produce your data. 

Note:  Users must have the System Manager, Group Admin, Case Admin, Case Manager, or 
eDiscovery Admin role with export or production or both folder privileges and access to the 
case data intended for export/production.

How to Use this Guide

This guide is divided into three main sections: 

1. Performing Exports

2. Running Productions 

Note:   This section discusses how to create production exports. For a definition and more 
information, refer to About Production Exports.

3. Troubleshooting Exports and Productions

Refer to this guide as a whole, or in part, depending on whether you use the platform for one or 
both processes. In either case, use the troubleshooting section to address any issues you may 
experience with exporting or producing your data.

When Should I Contact Support?

If issues do occur during export or production, first try the troubleshooting tips and techniques 
in this guide, and then refer to the sections on when and how you should contact Technical 
Support for assistance in Troubleshooting Exports and Productions.

About Export and Production
Case administrators may want to export or “package” case data in a format that can be more 
readily and directly loaded into a downstream application for review and analysis. Depending 
on output requirements, administrators can choose to create exports to either retain original 
document formats (called “native” export), or produce “metadata” exports. Metadata exports 
contain specific identification information about the document and can be converted to an XML 
using the industry standard EDRM XML 1.0 format, or other available load file formats. 
Administrators can choose to perform a “native only” export, or in metadata and production 
exports, select the option to include native file formats. For more information about metadata 
options, see Table 2: Metadata Export Selections in Performing Exports.
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When addressing non-standard export requirements, administrators can create custom 
templates using the “Load File Exports Templates” option under “All Processing” on the top 
navigation bar. For more information, see Using Load File Export Templates.

About Production Exports 

Production is the stage in the eDiscovery process in which documents are prepared for delivery 
to a requesting party. Further, when administrators want to package and deliver already-
produced documents according to specified requirements, they prepare a production export. 
For more information, see “Performing Production Exports” on page 88.
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Export and Production GuideExport and Production GuidePerforming Exports
This section describes what you should know before you export, and best practices for 
performing various exports, how to prepare for large-scale exports, and how to manage your 
exported jobs. For Production exports, see “Performing Production Exports” on page 88.

Refer to the following topics in this section:

• “Exports Overview” on page 12

– “Export Process Workflow” on page 13

– “About Metadata and Metadata Exports” on page 14

• “Export Best Practices” on page 15

– “Before You Export…” on page 15

• “Performing Exports” on page 16

– “Metadata Exports” on page 20

– “Production Exports” on page 25

– “Native Only Exports” on page 32

– “Managing Large Exports” on page 35

– “Using Load File Export Templates” on page 36

– “Applying Standard Load File Formats (Transforms)” on page 39

– “Exporting with Nested Attachments” on page 40

– “Exporting Email Header Search Results (Locator Hits)” on page 42

• “Generating logs” on page 47

• “Viewing, Managing, Accessing and Printing Exported Files” on page 48

– “View Results” on page 48

– “Export to an External Drive” on page 49

– “Stop/Restart an Export (for Metadata Exports)” on page 50

– “Retry or Finish the Export” on page 51

– “Use Auto-Retry” on page 52

• “Metadata Reference and Summary Information” on page 53

– “XML Export Files” on page 53

– “XML Summary Files” on page 58

– “Extended Metadata Summary” on page 64
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Exports Overview
Veritas eDiscovery allows you to efficiently export content in a variety of formats so that it can 
be presented to legal parties or ingested by other third party legal applications. Flexible export 
options make it easy to prepare, process and customize your documents and metadata. 

You can save time and avoid potential issues, (before and during the export process), by 
familiarizing yourself with the export workflow and following the guidelines in the Export Best 
Practices section.

Version 8.0 enhancements include:

• Item Level Production Exports — You can choose to export only relevant items in a 
Production export (any excluded, non-relevant family items will produce a slip sheet). For 
example, you can lock and produce an item level image and execute a production export of 
just that item level image. Similarly, you select certain items and not the entire document 
family in mixed mode for a production export. 

Note:   Metadata and Native Only exports only export entire document families and do not 
support exports at the item level.

• Tags and Folders Option for Metadata and Production Exports —You can select specific 
tags and folders during export. This is accomplished through the tags and folders Metadata 
Field tabs on the Metadata or Production export menus. Similar to what is available with 
other export options, you can save and preserve your tag and folder selections in a custom 
template for use in either Metadata or Production exports. You can also share the template 
with other users that have permissions set to access it. 
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Export Process Workflow

The export feature allows you to prepare documents in organized batches for review at a later 
stage.

Note:  This process also applies (in general) when performing a production export. See 
“Performing Production Exports” on page 88.

When a set of documents in a case are selected for export, case administrators then prepare the 
documents according to their output requirements. Requirements may specify multiple batches 
to be exported, customized report formats (such as specific delimiters), or require the data to be 
in one or more load file formats, such as CSV or DAT. The finished export is packaged as a .zip file 
ready for download or delivery. 

(Optionally, you can provide a description by labeling the export batch for quick reference later 
in your process. Start and end times are automatically associated with the batch.) 
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About Metadata and Metadata Exports

In a metadata export, the Veritas eDiscovery Platform creates an EDRM XML file containing 
metadata, and if selected, transforms the original file formats (loose files, PSTs, NSFs), into other 
specified formats for review in other downstream applications. (Native PSTs, which do not 
contain metadata, are converted to MSG formats). 

If native files are included in the metadata export, they are placed in a single directory with the 
files named based on their Veritas eDiscovery Platform document ID to streamline the process of 
loading the documents into a downstream review application. The original folder path 
information is contained in the XML metadata. (Language information and attachment hierarchy 
are included in XML exports.

What if Native Export is Required?

You can choose to perform a Native Only export. A Native Only export is where the structure and 
format of the original content is reproduced as it appeared in the native source. However, Veritas 
recommends using metadata export, as it contains more information about the files you are 
exporting, and native file formats can always be included. 

The following table shows how files are handled during export, depending on the type.

In a metadata export, more information about the files is included for quick reference.

Table 1:  Metadata and Native Exports and File Types

Export Type Original File Type Exported File Type Example

Metadata PST MSG 0.3.11.2809.msg

NSF NSF
(entryid added to message 
inside NSF file)

Loose Files Loose files with IDs:
<clearwell docid>.
<originalextension>

0.7.10.2134.xls

Native PST PST

NSF NSF

Loose Files Loose Files (same name) revenue.xls



   PAGE: 15

Export Best Practices
Whether you perform basic or advanced exports, you can prepare your export jobs with the 
following methods in mind to ensure your output is successful. This section describes how to 
handle large exports that are separated into multiple parts because they exceed the size limits 
that are specified in the system settings area. It also describes the format of the XML export and 
summary files. 

Before You Export…

When you prepare a set of documents for export, consider the following “checklist” items to 
help you select the appropriate options and ensure your export job will be successful:

• Check the size of your document set. 

– For larger exports, see “Managing Large Exports” on page 35.

– For export/print report file size limits and security, see “Performing Exports” on page 16.

Note:   Keep larger exports to less than 1,000,000 documents by using folders, tags, or 
export batches to organize document sets.

• Be aware that Metadata and Native Only exports do not support item level only exports 
(items are single attachments that are independent of the parent document or email). This 
means that any items that you have selected for Metadata and Native Only exports will also 
export all the other items in the same document family.

• Check your output requirements for the following:

– customized load files or native files. See “Metadata Exports” on page 20.

Note:   The Native Only export format does not create customized load files. Associated 
metadata is only available in the EDRM XML file. If you are required to export only native 
files use the Native Only option; otherwise Veritas recommends the Metadata option as the 
preferred export type.

– file and report formats. See “Exporting Metadata” on page 40 and “Extended Metadata 
Summary” on page 64.

– nested attachments. See “Exporting with Nested Attachments” on page 40.

– data security. See “Performing Exports” on page 16.

• Check whether a production export is required. See “Performing Production Exports” on 
page 88. 

• Will multiple exports of a certain format, or customized load file formats be required? See 
“Using Load File Export Templates” on page 36.

• Determine what reporting options you need. See “Extended Metadata Summary” on 
page 64.

• Consider adding utility nodes to improve export performance. Refer to the Utility Node 
Guide for deployment and more information.
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Performing Exports
On any search results screen that displays a list of documents, you can export documents to a 
zip file and download the file to your computer. (To export data to an external drive, see “Export 
to an External Drive” on page 49.

To export data in the Veritas eDiscovery Platform

1. Submit a search to find the documents you want to export (as described in "Performing 
Searches" in the Veritas eDiscovery Platform User’s Guide). 

2. You can export all the documents in your search results set, or select one or more 
documents on the current screen by clicking the check box next to the appropriate 
document(s) to be exported. To select all the documents on the current screen, click the 
check box in the column heading.

Note:   You can export production email files, attachments, and loose files for analysis in an 
external TIFF analysis application and then import the TIFF files back into the platform after 
the analysis is complete.

3. On any screen that shows a list of documents, click Actions and select Export.
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The export options window appears open to the Metadata tab.

In the default Metadata export, there are six sections available to select appropriate 
options: Metadata Fields, Format, Tags, Folders, Options, and Output. (Production exports 
include additional Production options.) You can set options that control how the files in 
folders, searches and tagged content are exported. These sections vary depending on the 
template type.

If you are performing multiple exports based on unique requirements, you can customize 
your settings by first creating a template. See “Using Load File Export Templates” on page 36.
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4. Click the tab for one of the following exports you want to perform:

– Metadata—Export a metadata file (EDRM XML, CSV, or other review application formats 
you may have installed) with optional user-generated metadata (such as tag and folder 
information) and native file content. This option is useful for productions that are being 
loaded into a downstream review application. For supported load file formats, see 
“Metadata Reference and Summary Information” on page 53. 

Note:   CSV files use ISO-8859-1 encoding. UTF files use UTF-8 encoding.

– Production—Export all the documents in your set that are part of a locked production 
folder. The number of documents may be less than the total number of documents 
shown in the top navigation bar. 

– Native Only—Export only the original native emails and files (with the original 
filenames and optionally their original folder structure) and any associated metadata. 
This is generally used for pure native productions. 

Notes:

– The Native Only export format does not create customized load files. Associated 
metadata is only available in the EDRM XML file. Use the Native Only option only if you 
are required to export native files; otherwise Veritas recommends the Metadata option 
as the preferred export type.

– Item level exports are only supported by a Production export. If items are selected for a 
Metadata or Native export, please be aware that ALL items in the same document family 
will be exported (in addition to the items that were originally selected).

5. Specify the following information, depending on your export type: 

– For Metadata exports, see Table 2: Metadata Export Selections.

– For Production exports, see Table 3: Production Export Selections.

– For Native Only exports, see Table 4: Native Only Export Selections.
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6. Click Export Selected or Export All (for the number of documents selected on the current 
screen, or the total number of documents).

Upon export, the Export Documents window appears:

By default, an export batch will be created for this selected or total document set with the 
file name clearwell_export. 

7. Choose an option:

A. If you want to create a batch, to include a description, enter a label for the batch 
(optional). 

B. If you do not want a batch created, click Do not create an export batch.

– To start the export, click Continue to Export.
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Metadata Exports

The following table lists all available sections and options associated with metadata exports 
(based on the “DEFAULT” template). 

Note:  Metadata Fields and Formats are only available in the “DEFAULT” template. Veritas 
recommends performing metadata exports as the preferred export type.

Table 2:  Metadata Export Selections

Section/Field Description

Template Keep the standard “DEFAULT” (DAT type) settings, or choose a template from the 
Templates window. 
Standard available templates include:

– EDRM XML 1.0

– Simple CSV [or] Simple CSV UTF

– Standard CSV [or] Standard CSV UTF 

– Standard DAT [or] Standard DAT UTF 

– Extended CSV [or] Extended CSV UTF

– Extended DAT [or] Extended DAT UTF

See XML Export Files for a full description of each type. 
Except for EDRM XML 1.0, the non-system templates listed above are now 
configurable. Some of the operations you can perform:

– Save—To intentionally overwrite the original template

– Save as New Template — Retains the original template while creating a new 
one based on it

– Delete—If the template is not used, it can be deleted so as to reduce obsolete 
selections in the pick list.

– Assign template to a specific case—These templates can be assigned to certain 
cases.

For more information, see “Modifying Non-System Templates” on page 38.
Or, select from any available custom-created metadata templates. To create a new 
metadata template (based on “DEFAULT” settings only) click Save as New 
Template. (For more information, see “Using Load File Export Templates” on 
page 36.)
Note:  Veritas supports both UTF-8 and ISO-8859-1 encoding for the “DEFAULT” 
template, and any customized templates. However, only UTF-8 encoding is 
supported for all other (“System” type) templates. 

If you choose one of the CSV or DAT formats, the Include EDRM XML 1.0 check box 
is automatically selected, allowing you to preserve and export the EDRM XML 
output in addition to CSV or DAT.
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Metadata Fields

Metadata 
(DEFAULT or custom templates only)
The group type of Metadata fields: 
• Standard—Fields included in all XML exports 
• Extended—Additional fields not included in Standard Metadata field
• Custom—Unique fields/attributes (as defined by administrator) in a load file
Then select from available fields to include in the export by moving them to the list 
on the right. 

Tags
Select from available tag list those tags you want to include in the export by moving 
them to the Fields to Export (In Order) box to the right. By default, tags are 
exported in separate columns. See Format -> Tags entry in this table to change the 
column format.

Folders
Select from available folder list those folders you want to include in the export by 
moving them to the Fields to Export (In Order) box to the right. By default, folders 
are exported in separate columns. See Format -> Folders entry in this table to 
change the column format.

Fields to Export 
(In Order) box

Highlight each selection, then click Rename to specify its display name, and order 
in which it will appear by clicking Move Up or Move Down. 
You can change the order of the Metadata, Tags and Folders sections and the fields 
within those sections but you cannot combine fields from different sections.

Format
(DEFAULT or custom templates only)

In the following fields, select the appropriate formats for the export file:
• Field Delimiter—Character separating the columns in the file

• Text Qualifier—Character marking the beginning and end of each field

• Encoding—Specify either UTF-8 or ISO-8859-1

• Include headers as first line—Select this option if the column headers should be 
the first line of the file

Date & Time By default, the Separate fields option is selected. Clear this option if the date and 
time should be grouped together in the same field. 

• File Extension—Type the file extension to be applied to the export file

Tags Select any of the tag format options to apply to your metadata export:
• Column Format—One tag per column (default) where each tag will be in a sepa-

rate column or All tags in one column (regardless of tag sets).

• Include full hierarchies with tag names — Hierarchal view of tag names

• Include Tag Event Comments — All tag event comments are included in the 
export file

Folders Select any of the folder format options to apply to your metadata export:
• Column Format—One folder per column (default) or All folders in one column.

• Include full paths with folder names— Hierarchal view of tag names

Table 2:  Metadata Export Selections

Section/Field Description
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Options

Select any of the following options to apply to your metadata export:
• Include batching information—Identification information about the batch of 

documents selected for export is included in the export file
• Include item notes—Item notes are included in the exported file.

– Include complete history—Entire history for all item notes are included in the 
export file

• Include discussion thread—Information about the discussion thread to which 
the selected documents belong are included in the export

• Include file flags—Flags associated with files are included in the export file
– Include one column per flag—Each flag will be in a separate column

• Include extended metadata—Extended data is included in the report 
• Include custodian & location info—Include custodian and location information 

in the exported zip file.
– One row per custodian—Each custodian will be in a separate row

To specify the custodians to include, click Select Custodians to open the 
selection window. You can search for custodians and then highlight entries to 
select them. Click OK to add your selections to the exported file.
Include email headers—Exports all email header information. To successfully 
export email header information (locator hits), you must have a viable email 
header search that have search hits. This will significantly increase the job 
completion time. It is strongly recommended that you only include email 
headers in conjunction with advanced search > email header criteria.

• Include: 

– Messages in native format & native loose files— Messages are exported in 
.msg format. Email messages are exported in their native format. Because of 
size limitations, Lotus Notes emails are exported into a single NSF container 
(not as individual message files). Selected alone, this option only exports the 
original messages (without envelope information) in native format.

Include Journal Information— Journal information can be included as 
part of the native file in two ways:

Note:  To export messages that do not contain any journal information in the 
message, leave the Include Journal Information option unchecked. 

– In original journal format— The contents of each item are exported in 
the same format as when imported. For example, when opening an 
exported item in Outlook, the Journal header information appears in the 
body, and the original body content is an attachment to that email.

– By merging recipients list— These are “unified” messages, expanding the 
original message to include merged information from the parent message. 
For example, when opening an exported item in Outlook, the actual 
contents of the email appears in the body (not in an attachment), and the 
recipient list includes the Journal recipients information.

Note:  For details about output folder structure for native files included in a 
metadata export, including rollover directories, see “File and Folder Structure 
for Metadata Output” on page 35.

– Messages in HTML format (excluding attachments) & native loose files—
Messages are exported in HTML format.

Table 2:  Metadata Export Selections

Section/Field Description
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• Include extracted text—Include the actual text of the documents in a text file. 
For redacted documents, only non-redacted text will be included in the extracted 
text.

– If no extracted text include an empty text file—Exports empty text files for 
documents that have content which cannot be indexed

– Include file metadata in extracted text—The file’s metadata is included as 
part of the text file

• Break out attachments as separate items—All attachments will be treated sep-
arate from the other exported files 

–Break out embeddings as separate items—All embedded content in 
attachment files will be treated separate from the other exported files

Table 2:  Metadata Export Selections

Section/Field Description
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Output

Select one of the following options:
• Create downloadable (zip) file—Creates a zip file that you can download by 

clicking Jobs on the top of the screen.

• Access from appliance only—Creates a file. The locations drop-down menu dis-
plays the available physical export locations. Select the location and the file will 
be saved to the target export location. Export locations are determined by Access 
Group membership and the type of configured locations associated with an 
Access Group. For more information on Access Groups see “Case Administration 
Guide: About Access Groups”.

Here are the factors that determine target export locations: 
If you are not a member of an Access Group configured for locations:

– The export file is written to the case home directory. 

– If the external location is set using the property browser, then select the target 
location from the drop-down location menu. See “Export to an External 
Drive” on page 49.

If you are a member of an Access Group configured for locations:
– Use the locations from the drop-down menu to select the target export file. 

The available locations are based on the access level settings allowed by your 
Access Group. To add or modify the list of export locations go to All Cases-
>Locations. To change the association of Access Groups to location, go to 
System > Users > Access Groups. 

Note:  In the Jobs window, move your 
cursor over the  symbol to view the 
information needed to identify the file. 
Your eDiscovery administrator can use 
the job ID to download the files.

WARNING: Each 
selected item 
also exports all 
other items in 
the same 
document 
family

Metadata exports do not support item level exports and will export ALL items in the 
document family.

Table 2:  Metadata Export Selections

Section/Field Description
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Production Exports
Selecting Export > Production tab displays Production export options:

A production export is similar to a metadata export, with added configuration and imaging 
options. For example, you can name documents based on a document’s production number 
instead of the Veritas eDiscovery Platform document ID, and include an Opticon image load file 
and specify image format including (if applicable) image resolution, color, and page selections. 
For multi-page image productions, the production number of the first page is used for naming.

The following table lists all available sections (similar to Metadata export options) associated 
with production exports (based on the “DEFAULT” template).
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Note:  Metadata Fields and Format options are only available in the “DEFAULT” template.

Table 3:  Production Export Selections

Section/Field Description

Template Keep the standard “DEFAULT” (DAT type) settings, or choose a template from the 
Templates window. 
Standard available templates include:

– EDRM XML 1.0

– Simple CSV [or] Simple CSV UTF

– Standard CSV [or] Standard CSV UTF 

– Standard DAT [or] Standard DAT UTF 

– Extended CSV [or] Extended CSV UTF

– Extended DAT [or] Extended DAT UTF

See XML Export Files for a full description of each type. 
Except for EDRM XML 1.0, the non-system templates listed above are now 
configurable. Some of the operations you can perform:

– Save—To intentionally overwrite the original template

– Save as New Template — Retains the original template while creating a new 
one based on it

– Delete—If a template is not used, it can be deleted to reduce obsolete selec-
tions in the pick list.

– Assign template to a specific case—These templates can be assigned to 
certain cases.

For more information, see “Modifying Non-System Templates” on page 38.
Or, select from any available custom-created metadata templates. To create a new 
production template (based on “DEFAULT” settings only) click Save as New 
Template. (For more information, see “Using Load File Export Templates” on 
page 36.)
Note:  By default, the platform supports UTF-8 encoding. To specify a different 
encoding option, see Extended Metadata Summary. 

If you choose one of the CSV or DAT formats, the Include EDRM XML 1.0 check box 
is automatically selected, allowing you to preserve and export the EDRM XML 
output in addition to CSV or DAT.

Production Options

Production Select the production batch to export. 

File Naming Select whether to name each file in the production by production number or 
production ID.
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Append slip-
sheet reason to 
exported 
filename

Slip-sheets are generated for a particular reason and act as placeholders for natives 
or images. Check this option if you want to append the reason to end of the 
filename for each slip-sheet to easily identify the files in a directory later. For 
example: 
filename-000002_Not_Included_In_Production_Slipsheet.tif

Slip-Sheet Reasons: 
• Fully Redacted—Item was Redacted completely 

• Imaging Error (Production Error) — Unable to create image of item 

• Conversion Error (Production Export Error) — Image failed to convert to TIFF 

• Native Not Imported (LFI Native Unavailable) — Load File did not import Native 

• Native Placeholder (Mixed Mode Image) — Bates stamped Native placeholder 

• Not Produced Item— Item not Produced with family 

Include native 
files

Select one of the following native file options:
• Export all as HTML—All native files to be exported in HTML format.

• Notes as HTML, all others pure native—Includes Lotus Notes as HTML files, all 
other supported files in pure native format. Native files are included only for doc-
uments that are not redacted.

Note:  When you select this option for NSF source files, the NSF output is put in a 
folder shared across all the rolled over XML files. The NSF files are not separated into 
an XML specific native folder.

• Include Journal Information

When the option is unchecked, the journal information is not included in the native 
files, but the merged recipient lists can still be exported as metadata.
Messages in HTML format will always have the merged recipient list (By merging 
recipients list).

– In original journal format. (Same as for Metadata exports) The contents of 
each item are exported in the same format as when imported. For example, 
when opening the exported item in Outlook, the Journal header information 
appears in the body, and the original body content is an attachment to that 
email

– By merging recipients list. (Same as for Metadata exports) These are “unified” 
messages, expanding the original message to include merged information 
from the parent message. For example, when opening the exported item in 
Outlook, the actual contents of the email appears in the body (not in an 
attachment), and the recipient list includes the Journal recipients information. 

Table 3:  Production Export Selections

Section/Field Description
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Include images Select this option if the production export should also include images according to 
the specified criteria:
• Image Format—Select either TIFF or PDF

• DPI—Resolution in dots per inch (DPI), for TIFF only

• Color Style—Black & white, or Color

• Color Depth—2, 4, 8, 24, or 32

• Each File—Presentation of each file on a single page or multiple pages

• Page Size—Selection of page sizes.

Select the options:
• Include Opticon image loadfile—Select to add Opticon image loadfile. If the 

Opticon formatted image loadfile should be included with the production export. 
For more information about Opticon files and formats, refer to Veritas’s Load File 
Import Guide.

• Validate TIFF Files Select to check for any corrupt or badly-generated files to 
ensure that they are not submitted to any parties receiving the output from the 
production export.

Hide Redaction 
Reasons

Select the option to exclude redaction reasons from the production export.

Include 
extracted text

Include the actual text of the documents in a text file.
– If no extracted text include an empty text file—Exports empty text files for 

documents that have content which is cannot be indexed

– Include file metadata in extracted text—The file’s metadata is included as 
part of the text file

– Export images and text into same directory (TIFF text pairing)—A TIFF file 
and its matching text file images are exported into the same directory location. 

Metadata Fields

Metadata 
(DEFAULT or custom templates only)
The group type of Metadata fields: 
• Standard—Fields included in all XML exports 

• Extended—Additional fields not included in Standard Metadata field

• Custom—Unique fields/attributes (as defined by administrator) in a load file

Then select from available fields to include in the export by moving them to the list 
on the right. 

Tags
Select from available tag list those tags you want to include in the export by 
moving them to the Fields to Export (In Order) box to the right. By default, tags 
are exported in separate columns. See Tags subsection to change the column 
format.

Table 3:  Production Export Selections

Section/Field Description
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Folders
Select from available folder list those folders you want to include in the export by 
moving them to the Fields to Export (In Order) box to the right. By default, folders 
are exported in separate columns. See Folders subsection to change the column 
format.

Fields to Export 
(In Order) box

Highlight each selection, then click Rename to specify its display name, and order 
in which it will appear by clicking Move Up or Move Down. 
You can change the order of the Metadata, Tags and Folders sections and the fields 
within those sections but you cannot combine fields from different sections.

Format
(DEFAULT or custom templates only)

In the following fields, select the appropriate formats for the export file:
• Field Delimiter—Character separating the columns in the file

• Text Qualifier—Character marking the beginning and end of each field

• Encoding—Specify either UTF-8 or ISO-8859-1

• Include headers as first line—Select this option if the column headers should 
be the first line of the file

• Multi-value Delimiter—Character separating distinct values within a column, 
such as when several email addresses are in a “To” field

Date & Time By default, the Separate fields option is selected. Clear this option if the date and 
time should be grouped together in the same field. 
Select from available date and time formats.

• File Extension—Type the file extension to be applied to the export file

Tags Select any of the tag format options to apply to your production export:
• Column Format—One tag per column (default) where each tag will be in a sepa-

rate column or All tags in one column (regardless of tag sets).

• Include full hierarchies with tag names — Hierarchal view of tag names

• Include Tag Event Comments — All tag event comments are included in the 
export file

Folders Select any of the folder format options to apply to your production export:
• Column Format—One folder per column (default) or All folders in one column.

• Include full paths with folder names— Hierarchal view of tag names

Table 3:  Production Export Selections

Section/Field Description
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Options

Select any of the following options to apply to your export:
• Include batching information—Identification information about the batch of 

documents selected for export is included in the export file

• Include item notes—Item notes are included in the exported file

– Include complete history—Entire history for all item notes are included in the 
export file

• Include discussion thread—Information about the discussion thread to which 
the selected documents belong is included in the export

• Include file flags—Flags associated with files are included in the export file

– Include one column per flag—Each flag will be in a separate column

• Include custodian & location info—Include custodian and location information 
in the exported zip file

– One row per custodian—Each custodian will be in a separate row

To specify the custodians to include, click Select Custodians to open the 
selection window. You can search for custodians and then highlight entries to 
select them. Click OK to add your selections to the exported file.

– Include email headers—includes email header information for documents 
with search hits. Documents can have multiple headers but only headers with 
search hits will be exported.

Note:  This option requires email criteria in your search and can significantly 
increase the job completion time.

• Break out attachments as separate items—All attachments will be treated sep-
arate from the other exported files. 

Note:  This option is not available for Production Export.

–Break out embeddings as separate items—All embedded content in 
attachment files will be treated separate from the other exported files

Output

Table 3:  Production Export Selections

Section/Field Description
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Select one of the following options:
• Create downloadable (zip) file—Creates a zip file that you can download by 

clicking Jobs on the top of the screen.

• Access from appliance only—Creates a file. The locations drop-down menu dis-
plays the available physical export locations. Select the location and the file will 
be saved to the target export location. Export locations are determined by Access 
Group membership and the type of configured locations associated with an 
Access Group. 

Here are the factors that determine target export locations: 
If you are not a member of an Access Group configured for locations:

– The export file is written to the case home directory. 

– If the external location is set using the property browser, then select the target 
location from the drop-down location menu. See “Export to an External 
Drive” on page 49.

If you are a member of an Access Group configured for locations:
– Use the locations from the drop-down menu to select the target export file. 

The available locations are based on the access level settings allowed by your 
Access Group. To add or modify the list of export locations go to All Cases-
>Locations. To change the association of Access Groups to location, go to 
System > Users > Access Groups. 

Note:  In the Jobs window, move your 
cursor over the  symbol to view the 
information needed to identify the file. 
Your eDiscovery administrator can use 
the job ID to download the files.

WARNING: 
When exporting 
selected items, 
the whole 
family is 
exported as 
defined in the 
Production

Actual export counts may be higher than what is shown.
Slip-sheet placeholders are added for each document family item that is not in the 
production.

Table 3:  Production Export Selections

Section/Field Description
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Native Only Exports

Selecting Export > Native Only tab displays Native export options:

Note:  Use the Native Only option only if you are required to export native files; otherwise 
Veritas recommends performing metadata exports as the preferred export type.

When you choose a native-only export, loose files are exported into a directory structure that 
mirrors the original directory structure from which the files were crawled, with some character 
substitutions when necessary. For example, if loose files are crawled from:

– \\sierra\public\user\testfiles

– c:\documents

– settings\user\my documents

then they will be exported as:

– __sierra\public\user\testfiles

– c_\documents

– settings\user\my documents

If loose files and messages are exported together, loose files and email (PST and NSF) files are 
included in the same zip file. The following table lists the selections available for Native Only 
exports.

Note:  Native Only exports may contain empty folders if the end file has a path that exceeds 255 
characters. In such cases, an exception folder is created (in addition to the original folder)

Table 4:  Native Only Export Selections

Field Description

Options

Select one of the following de-duplication options:
• Duplicate (export all copies)—Exports all copies of emails and files in their 

original folder/directory structure, even duplicates

• Deduplicate (export single copy)—Eliminates duplicates

Select the Preserve folder hierarchy option to include the path for each folder. 
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–If you choose to preserve folder hierarchy with deduplication, and the document is 
found in multiple folders, then one of the valid folder paths is automatically 
selected. Select the Use short, most relevant folder paths option to eliminate 
the common root folder path from the export. 

–For example, if the actual full folder path is: 
\\Server\public\cases\companyName\caseName \custo-
dian1 \laptop\memos\, 
then \\Server\public\cases\companyName\caseName\ 
would be suppressed and the folder path is listed as custo-
dian1\laptop\memos\.

• Group messages/files by custodian—Group the exported messages and files 
according to custodian. Click Select Custodians to select and group the exported 
messages by custodian.

Email 
Container 
Files

Select one of the following container file options: 
– Single file—Create a single email container file (PST format). using a folder 

structure to organize messages from different sources/custodians. Specify a file 
name (default is Clearwell/Export). Separate files will be created for Exchange and 
Notes messages if both are present.

• Multiple files—Create a separate container file for each custodian or mailbox/file-
name. If Group messages/files by custodian are checked, there will be one container 
per custodian, otherwise, there will be one container file per mailbox/filename. Sepa-
rate files will be created for Exchange and Notes messages if both are present.

Note:  Emails ingested as loose files are natively exported as loose files and will not be 
exported in email container files.

Table 4:  Native Only Export Selections

Field Description
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Output

Select one of the following options:
• Create downloadable (zip) file—Creates a zip file that you can download by clicking 

Jobs on the top of the screen.

• Access from appliance only—Creates a file. The locations drop-down menu displays 
the available physical export locations. Select the location and the file will be saved to 
the target export location. Export locations are determined by Access Group member-
ship and the type of configured locations associated with an Access Group. 

Here are the factors that determine target export locations: 
If you are not a member of an Access Group configured for locations:

– The export file is written to the case home directory. 

– If the external location is set using the property browser, then select the target 
location from the drop-down location menu. See “Export to an External Drive” on 
page 49.

If you are a member of an Access Group configured for locations:
– Use the locations from the drop-down menu to select the target export file. The 

available locations are based on the access level settings allowed by your Access 
Group. To add or modify the list of export locations go to All Cases->Locations. To 
change the association of Access Groups to location, go to System > Users > Access 
Groups. 

Note:  In the Jobs window, move your cursor 
over the  symbol to view the information 
needed to identify the file. Your eDiscovery 
administrator can use the job ID to download 
the files.

Each selected 
item also 
exports all 
other items 
in the same 
document 
family.

Native Only exports do not support item level exports and will export ALL items in the 
document family.

Table 4:  Native Only Export Selections

Field Description
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Managing Large Exports

File and Folder Structure for Metadata Output

Each batch folder contains subfolders for native, text, and image files, based on file type options 
selected for export.

Within each of the native, text, and image subfolders, batched folders are created, named by run 
number, such as 0000001, and 0000002. These batched folders are created using the property 
esa.export.production.image.max_folder_size, which rolls over folders based on the number of files 
the folder contains. (To modify the folder size, in All Cases view on the navigation bar, go to System > 
Support Features, and select Property Browser.)
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Using Load File Export Templates

You can fully customize metadata and production export formats by creating and saving Load 
File Export templates. Export templates allow you to create standardized load file formats with 
unique specifications, and can be shared across multiple cases. After creating the template (in 
System view), it becomes available for use for the logged in user. This is useful if you will have 
multiple exports to perform using the same settings. 

Creating Templates

There are two places to create new templates. To create and assign a new template for multiple 
cases, system administrators use the Load File Exports Templates option under All 
Processing on the top navigation bar (as described in this section). 

Note:  You must have system administration privileges to create templates from the All Cases 
view, and assign/restrict access to selected cases. 

Within a single case, case administrators can save settings as new templates (based on 
“DEFAULT” template only) from the Action > Export > Metadata [or Production] tab in the 
Analysis & Review module. 

See Table: Metadata Export Selections, or Table: Production Export Selections.

To create a template (All Cases)

1. In the All Cases view, on the top navigation bar, click All Processing > Load File Export 
Templates. The template options display, open to the Metadata tab:

(Click the Production tab to create a Production load file export template.)

2. Click New Template.
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The Metadata template screen displays, similar to a regular Metadata export. 

Note:   The tags and folders that you can select for a Metadata export template are case-
specific and not accessible from the ALL PROCESSING module -> create template 
workflow that system administrators use to create non-case specific templates. 

In the Template information section, enter a name for the template. (File type will always be in supported CVS/DAT format.)
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A. To assign this template to selected cases only, select the Restrict access to the 
following cases option. A list of available cases appears in the Case access box.

Click the “X” on each case name to remove it from the list, restricting access to the 
remaining case(s).

3. To complete the remaining sections, for more information refer to the same options for 
your template type, as described in Table 2: Metadata Export Selections, or Table 3: 
Production Export Selections. 

4. When finished, click Save Template. (To create additional templates with modified options 
based on this template, click Save as New Template.)

A list of templates created for selected cases appears on the main Load File Export 
Templates screen, under the appropriate tab for your export type.

Applying Custom Templates

Once a Load File Export Template is created, users can then select from available templates (or 
save modifications to the “DEFAULT” template as a new template) when creating a Metadata or 
Production export in the Analysis & Production module (as described in Metadata Exports and 
Production Exports). 

Modifying Non-System Templates

The product supports a number of different transforms that can be used to convert EDRM XML 
output into another format. Table 5 lists both the system transform template (EDRM XML 1.0) 
and a series of non-system templates.

Starting with release 7.1.3, you can modify or adapt any non-system export formats listed in the 
table below to suit your preferred way of working with downstream application requirements. 
This flexibility allows you to create more shareable export templates. It also ensures that you 
have transparency into the options and fields of existing non-system base templates as well as 
the changes that comprise your new template. 

To modify an existing template

1. Click the metadata or production drop-down (showing the templates) and select one of the 
available non-system load files or transforms as described in the Table 5.

2. Select any other metadata export options or fields (as described in Table 2 or 3, depending 
on your export type), and complete the steps. 

3. When finished, click Save as New Template (this preserves the original template). 

The new template now appears on the main Load File Export Templates screen, under the 
appropriate tab for your export type.
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Applying Standard Load File Formats (Transforms)

For metadata exports, (particularly if you are using an older version that does not contain 
templates), you can choose to transform the XML exported data into another format based on 
your downstream application requirements. The following standard available load files are 
supported:

To apply a supported load file

1. Click the metadata drop-down (showing the template) and select one of the available load 
file (transforms) as described in the table.

2. Select any other metadata export options (as described in Table 2 or 3, depending on your 
export type), and complete the steps. See Performing Exports.

Table 5:  Load File Formats

Type Description

EDRM XML 1.0 Electronic Discovery Reference Model (EDRM) XML.

Simple CSV/ 
Simple CSV UTF

Contains the platform’s export date, Doc ID (in dot notation format), list of 
custodians, and list of tags.

Standard CSV/ 
Standard CSV UTF

Contains core metadata, fields, and tags (but not extended metadata such 
as comment properties of Microsoft Office documents). Entries are 
delimited with standard quote-and-comma delimiters.

Standard DAT/ 
Standard DAT UTF

Contains core metadata, fields, and tags (but not extended metadata). 
Entries are delimited with Concordance delimiters. 

Extended CSV/ 
Extended CSV UTF

Contains extended metadata, fields, and tags. All Standard CSV fields are 
included. 

Extended DAT/ 
Extended DAT UTF

Contains extended metadata, fields, and tags. All Standard DAT fields are 
included. 
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Exporting with Nested Attachments

For metadata document exports, if you choose to include a separate copy of attachments, the 
system will do true nesting using the same convention that it uses for first-level attachments. In 
particular, if an email has a .msg attachment that includes a .doc and an .xls attachment, the 
system performs a full parent/child separation upon export.

For example, consider an email with an attached email that has two .zip attachments and a .msg 
attachment, and assume that the DocID is 0.7.1.1. Parent email 1 has the following parent/child 
structure:
Parent email 1
a.msg

a.zip
a.doc
b.doc

c.zip
a1.doc

b.msg
z.doc
a.doc

The system will export the following records in the EDRM XML load file:

EDRM - XML
0.7.1.1 Parent email 1

0.7.1.1.1 a.msg
0.7.1.1.1.1 a.doc (with a.zip reference in locator path)
0.7.1.1.1.2 b.doc (with a.zip reference in locator path)
0.7.1.1.1.3 a1.doc (with c.zip reference in locator path)
0.7.1.1.1.4 b.msg

0.7.1.1.1.4.1 z.doc

0.7.1.1.1.4.2 a.doc

For all attachments (from a.msg to a.doc), the locator in the <Locations> record of the XML will 
contain the full path to the file, including all .msg/.eml and .zip/.rar containers. For example, the 
locator for the second a.doc (0.7.1.1.1.4.2) will be in the form c:\(source path)\email.pst\(MAPI 
ID)/a.msg/b.msg/a.doc, because a.doc was found within b.msg, which was found within a.msg.

If you choose to export email messages in HTML format, then this approach will apply to the 
parent emails as well as any nested .msg and .eml messages that are found attached to the 
parent. However, If you choose to export email messages in native format, then both the parent 
and the embedded emails will be exported in native format.

Note:  In native-mode, .msg and .eml files do not have their attachments removed, so the 
attachment is effectively exported twice (once inside the parent, and once stand-alone). 
However, the extracted text only contains the extracted text of the parent. If this is undesired, 
you can use the HTML mode to produce message content in HTML format.

Exporting Metadata

From a metadata perspective, .msg/.eml attachments are treated as e-mails during export. The 
file type of the document in the XML metadata is “email,” and all email-specific metadata (such 
as Subject, To, From, and Cc) are produced.
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Any standard file attachments of .msgs/.emls have standard loose file metadata extracted as is 
appropriate for their file type.

There are some special considerations around the three Attachment fields in the metadata 
(#HasAttachments, #AttachmentCount, and #AttachmentNames). All of the nested attachments 
associated with a parent email are rolled up to the parent email (this parallels how the 
documents are presented to the user in the UI).

For the example in “Exporting with Nested Attachments” on page 40, the parent email document 
(0.7.1.1) will have the following values for those fields:

• #HasAttachments: true

• #AttachmentCount: 7 (the total number of attached documents for all levels, excluding any 
containers)

• #AttachmentNames: a.msg; a.doc; b.doc; a1.doc; b.msg; z.doc; a.doc

The child email attachments of the parent (a.msg and b.msg) will have the following values for 
the attachment fields:

• #HasAttachments: false

• #AttachmentCount: 0

• #AttachmentNames: <blank>

The information is presented this way to provide a single level parent/child hierarchy, or group, 
when exporting from Veritas’s eDiscovery Platform into a downstream review platform.

Note that the full hierarchical information is still available in two places:

• The LocationURI of each document contains the full path to each child document, 
including all of its parents.

• The Document ID contains the full path to each child document, including all of its parents.

Parent/Child Relationship Section

The system’s EDRM XML export includes a Relationship section that shows the document family 
relationship between parent and child documents.

For consistency and ease of integration with review platforms, the system does not produce a 
fully-nested relationship section, but instead produces one in which all of the nested 
attachments of the top-level parent email document are presented as single-level children of 
the parent. The full n-level nesting structure is present and embedded in the Document ID 
structure (“Exporting with Nested Attachments” on page 40) and the document locator string. 
However, for grouping purposes, users can see a single-level representation of a parent email 
document and all of its child attachments.
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Exporting Email Header Search Results (Locator Hits)

Starting with 7.1.3, the platform can export email header search results for further analysis or for 
use by other applications. 

An export of email header field results requires the following:

1. A search for email header was run using Advanced Search and the search results were 
selected for export.

2. In the export dialog box, the metadata option Include custodian & location info is 
checked prior to selecting and running Export.

Export creates a .ZIP file of your email header search results. The email headers are grouped 
according to email header type, stored as CSV/DAT files and use the same load file import 
delimiters to ensure consistency. To assist in troubleshooting and problem identification, any 
email header locator errors are listed by column in the file.

Understanding Email Header Types

There are many types of email header fields. To assist in identification, the system groups them 
into categories. For a list of the supported fields see “List of Email Header Fields” on page 43.

Here are the Email Header Field categories: 

• Standard — Email headers that are currently part of RFC-2822 Internet Standard

• Custom — User-entered email header fields into the system

• Clearwell Custom—Pre-configured set of email headers

• Non-General —Email headers that are not generally seen as header in emails but are part of 
RFCs

• Non-Standard — Email headers that are not standardized but can be seen in headers 

• Proposed — Email headers that are still being standardized via various RFCs

• Junk — Email headers that do not fall in any of the other categories

Exporting Default and Customized Email Header Types

The platform provides a default set (such as Received, References, X-Originating-IP) of email 
header fields that you can select and export. Alternatively, if you have chosen to extend the set 
of default email header fields, the workflow is different and involves setting the email header 
field type (such as Standard, Non-General and so on) and associated field(s) in the property 
browser. See “To export email header fields” on page 43.

Email Header Export Files

Filename Description

EmailHeaders_S_C Groups Standard and Custom email header information

EmailHeaders_NNG_NS_P Groups Non-General, Non-Standard and Proposed email header 
information

EmailHeaders_J Groups any email headers that do not fit in the above categories
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To export email header fields

This example enables a custom email header export property with the email header 
fields: x-linkedin,dkim-signature.

1. Go to System > Support Features, and select Property Browser.

2. Enter the name of the property: esa.email.header.custom.fields

3. In New value, enter the email header field (in this example it is from the Custom category) 
by setting it to: field x-linkedin,dkim-signature

4. Click Submit to save your setting.

List of Email Header Fields

Email Header Export Files

Email Header Type Property Name

Standard esa.email.header.standard.fields

Non-Standard esa.email.header.non.standard.fields

Non-General esa.email.header.non.general.fields

Proposed esa.email.header.proposed.fields

Custom esa.email.header.custom.fields

Clearwell Custom esa.email.header.cw.custom.fields 

Standard, Non-Standard, & Non-General Email Header Fields

Standard Non-Standard Non-General

Return-Path NNTP-Posting-Host DL-Expansion-History

MIME-Version Also-Control Alternate-Recipient

bcc Message-Context Disclose-Recipients

cc Apparently-To Original-Encoded-Information-Types

Distribution Approved Content-Return

From Approved-By Generate-Delivery-Report

Sender Fax Prevent-NonDelivery-Report

To Telefax Obsoletes

Disposition-Notification-Options For-Approval Content-Identifier

Disposition-Notification-To For-Comment Delivery-Date

Original-Recipient For-Handling Expiry-Date

Reply-To For-Handling Reply-By
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Content-Base Mail-System-Version Incomplete-Copy

Content-ID Mailer Priority

Content-Location Originating-Client Language

In-Reply-To X-Mailer Conversion

Message-ID X-Newsreader Conversion-With-Loss

References X-MimeOLE Message-Type

Comments User-Agent Autoforwarded,

Content-Description Newsgroups Discarded-X400-IPMS-Extensions

Keywords Originator Discarded-X400-MTS-Extensions

Subject Originator-Info

Date Phone

Lines X-Envelope-From

Content-Transfer-Encoding X-Envelope-To

Content-Type Envelope-To

Encoding X-Face

Resent-Reply-To X-RCPT-TO

Resent-From X-Sender

Resent-Sender X-X-Sender

Resent-Date Posted-To

Resent-To X-Admin

Resent-cc Errors-To

Resent-bcc Return-Receipt-To

Resent-Message-ID Read-Receipt-To

List-Archive X-Confirm-reading-to

List-Help Return-Receipt-
Requested

List-ID Registered-Mail-Reply-
Requested-By

List-Owner Followup-To

List-Post Mail-Followup-To

List-Subscribe Mail-Reply-To

List-Unsubscribe Abuse-Reports-To

Received X-Complaints-To

X-Report-Abuse-To

Standard, Non-Standard, & Non-General Email Header Fields (Continued)

Standard Non-Standard Non-General
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Mail-Copies-To

X400-Content-Return

Article-Names

Article-Updates

Content-Alias

Delivered-To

X-Loop,Replaces

See-Also

Supersedes

Translated-By

Translation-Of

X-UIDL

X-URI

X-URL

X-IMAP

Organisation

X-OriginalArrivalTime

PICS-Label

Precedence

X-MSMail-Priority

X-Priority

Content-Length

Content-Alternative

Content-Conversion

Content-Class

Content-SGML-Entity

X-MIME-Autoconverted

Cancel-Lock

Cancel-Key

List-Digest

Mailing-List

X-Mailing-List

List-Software

Standard, Non-Standard, & Non-General Email Header Fields (Continued)

Standard Non-Standard Non-General



 PAGE: 46

List-URL

X-Listserver

X-List-Host

Fcc

Speech-Act

Status

X-No-Archive

Organization

Summary

Expires

Xref

Path

Control

Proposed & Veritas eDiscovery Platform Custom Email Header Fields

Proposed Veritas eDiscovery Platform 
Custom

References X-Originating-IP

Comments

Content-Description

Keywords

Subject

Date

Lines

Content-Transfer-Encoding

Content-Type

Encoding

Resent-Reply-To

Resent-From

Resent-Sender

Resent-Date

Resent-To

Resent-cc

Standard, Non-Standard, & Non-General Email Header Fields (Continued)

Standard Non-Standard Non-General
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Generating logs

Starting with release 9.1, users can export an Excel-based metadata report of each item 
withheld or redacted in one or more production folders. For details on the privilege and 
redaction logs, see “Logs” on page 93.

Content-Disposition

Importance

Sensitivity

Content-Language

Content-MD5

Content-Features

Resent-bcc

Proposed & Veritas eDiscovery Platform Custom Email Header Fields (Continued)

Proposed Veritas eDiscovery Platform 
Custom
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Viewing, Managing, Accessing and Printing Exported Files
Once you have begun the export, you can monitor progress from the Jobs window. The 
“Running” status is displayed while the job is in process. In the cases when the job is stopped, 
interrupted, or you need to pause the export before it completes, you can use one or more of 
the following methods to manage the process to maximize your time and job efficiency:

• “View Results” on page 48

• “Export to an External Drive” on page 49

• “Stop/Restart an Export (for Metadata Exports)” on page 50

• “Retry or Finish the Export” on page 51

• “Use Auto-Retry” on page 52

View Results

When a job has completed successfully, you can access exported files either from an external 
location (if exported to external drive) or from the locations as directed in the information text 
bubble displayed next to the export job.

To view the results

1. Click Jobs at the top of the screen to view the status of the task. A check mark icon is 
displayed next to the Jobs link to indicate that the file is ready. 

Note:   If a job fails, a warning icon is shown.

2. If settings change or new documents are added to the case while the export is in progress, 
you are alerted of this state in the jobs window.

3. If an error occurs during the export:

– In the Jobs window, the status of your production displays, with a link to Find failed 
docs under the Actions column. Click the link to view details for the errors that occurred 
to each document.

– When you click the link, the Export Errors filter appears in the Filter list, displaying the 
errors by type. This allows you to address the issues before re-running the production.
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4. If the task completed successfully, click Download in the Jobs window to open or save the 
file. If some documents were not exported, a Continue link allows you to retry the export.

To delete a completed task, either from the System > Jobs screen, click trash  icon next to 
the task, or from the Jobs window, click cancel  icon next to the Date stamp for the task. To 
cancel a running task, click Stop in the Actions column. This will also allow metadata and 
production exports to be resumed. To resume, click play  icon after the job has stopped.

Click Jobs to close the Jobs window.

Export to an External Drive

If you want to export a set of documents to a location off-appliance, such as to an external drive, 
using the Property Browser support feature can be useful when:

• The backup does not back up the large export.

• You want to avoid the windows file path limitation of 256 characters.

• The export “retry” option does not copy the export before retrying.

Note:  There is no option to download the export zip file when an external location is specified.

To configure exports off-appliance (external drive)

1. In the All Cases view, click System > Support Features.

2. On the Support Features screen, select the Property Browser feature.

3. For Name of property to change, enter: 
esa.export.joboutput.external

4. For the New value, enter the path to the external drive. For example:

\\mynas01\myexpdata\ExportOutputDir

5. Make any other selections, then confirm by selecting the check box Confirm change. Are 
you sure?

6. Click Submit.

To verify external export setup in Property Browser

Use the following procedure to verify if your eDiscovery server is configured for external 
exports.

1. Go to System > Support Features, and select Property Browser.

2. For Pattern to match, enter the property: esa.export.joboutput.external

3. Click Submit.

4. Evaluate the output:

A. Local: If the property has ever been set and removed, the property browser utility 
displays esa.export.joboutput.external = . The blank space means that exports are local.

B. External: If esa.export.joboutput.external = \\sharename\external\exportlocation than 
exports are stored external to the eDiscovery server.
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Stop/Restart an Export (for Metadata Exports)

For XML or Production exports with large volumes of data, such as production export jobs, 
performing the export can typically take several hours or days to run. 

Note:  This feature applies to Metadata and Production exports only. 

If the system is shut down or restarted for maintenance during a paused job, the export job will 
resume from the same point at which it was stopped—essentially pausing the job. If you decide 
to pause a job, then you must then restart the job. Otherwise, paused jobs resume automatically 
(such as from a system shutdown, in which the job will resume automatically upon restart). See 
Use Auto-Retry or for on demand, see Retry or Finish the Export.

While an export job is running, from the Jobs window, click the “stop” icon under Actions to 
pause the job. The status changes from “Running”, to “Stopping” to “Partially completed”. An 
InfoBubble icon appears alerting you that your job was stopped or aborted. While a job is 
stopped or only partially complete, the files are not yet available to be viewed.

Note:  Do not attempt to view the files in their partially completed state with file management 
tools like Windows® Explorer, or file commander, as it may corrupt the export job and prevent it 
from completing successfully upon restart.

When you are ready to restart the job, click the “start” icon. Your export job will continue from 
the point at which it was stopped, displaying the status “Starting” then returns to “Running”. If 
no errors occur, the job completes successfully. While an export job is running, from the Jobs 
window, click the “stop” icon under Actions to pause the job. The status changes from 
“Running”, to “Stopping” to “Partially completed”. An InfoBubble icon appears alerting you that 
your job was stopped or aborted. While a job is stopped or only partially complete, the files are 
not yet available to be viewed.

When you are ready to restart the job, click the “start” icon. Your export job will continue from 
the point at which it was stopped, displaying the status “Starting” then returns to “Running”. If 
no errors occur, the job completes successfully.
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Retry or Finish the Export

If the export was not able to complete successfully, the Jobs window displays a message 
indicating an error. Typically, this message describes that the export was Partially Completed. 
This indicates that some, or all, of the documents were unable to be exported.

At this point, links are provided to Retry or Finish the export. Selecting “Retry” attempts to 
export the remaining documents again. If the failure was caused by a temporary problem (for 
example, intermittent access to the source data) and the problem has been corrected, selecting 
Retry may allow the export to complete successfully.

Selecting “Finish” will finish the export without attempting to export the remaining documents. 
Typically, Veritas suggests selecting Finish in order to provide the information needed to 
diagnose why the original export failed. (See Diagnose a Failed Export in the Troubleshooting 
section.)
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Use Auto-Retry

In cases when a job fails, due to an intermittent service or access issue for example, you can set 
the export job to retry automatically for any number of attempts to finish the job (the default is 
2). To do this, you can use the export.retry property in the property browser in the platform’s 
Support Features tool.

To set system to auto-retry an export job

1. In the All Cases view, click System > Support Features.

2. On the Support Features screen, for step 1, select the Property Browser feature.

3. For Name of property to change, enter: 
esa.common.export.retry

4. For the New value, enter the numeric value for the number of times you want the system to 
try exporting the job. For example: 5

5. Make any other selections, then confirm by selecting the check box Confirm change. Are 
you sure?

6. Click Submit.

From the Jobs window, select the export job you want to run. Your export job will continue 
running, or attempt to restart where it left off if there is an intermittent interruption in service or 
access to the source. 

Printing Confidentiality Footer for PDF Reports

You can create a confidentiality footer for printed PDF reports. To create the confidentiality 
footer, navigate to the menu by selecting the System view from the top navigation bar, and 
then clicking the Settings > Print tab. 
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Metadata Reference and Summary Information
After your metadata export is complete, refer to this section for information on extended 
metadata XML tags (used for the summary file generated for export and print tasks), export file 
formats, and a summary of all metadata exported in the platform for the various export and 
report options selected.

• “Extended Metadata Reference” on page 53

• “XML Export Files” on page 53

• “XML Summary Files” on page 58

• “Extended Metadata Summary” on page 64

Extended Metadata Reference

This section provides a reference for exporting extended metadata. 

All XML tags provided are inside <Document> sub-records that are inside the top-level 
<Documents> record, with the exception of folder information (the last row of the table). 
Project information is contained in the <Folders> record outside <Documents>).

The system checks the following categories of files for extended metadata based on their 
Outside In strong FileID: 

• Word (all versions) 

• Excel (all versions) 

• PowerPoint (all versions) 

• PDF (all versions) 

• RTF 

To extend the categories that are checked for in other file types, change the 
esa.export.xml.fileids.office property using the property editor.

XML Export Files

Exported documents will be in one or more files, depending on the specified maximum XML file 
size (refer to "Defining System Settings" in the -System Administration Guide). If the native files are 
exported, they are renamed using the MD5 hash value of the file content, and included in a 
single folder. The <LocationURI> tags in the XML file map the MD5-encoded names to all 
occurrences of the original files in their original locations.

Note: EDRM XML is always generated. If you choose another format, the system generates 
that format as well. 
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Table 6:  XML Export File Formats

Tag Name Description

<Root MajorVersion= 
MinorVersion= CaseId= 
Description= >
</Root>

The general container for the exported documents. 
• MajorVersion="<n>". Major version of the export format.

• MinorVersion="<n>". Minor version of the export format.

• CaseId="<name>". Case name.

• Description="<text>". Indicates, the case name, user name, and date and 
time of the export. The date and time format for all tags is yyyy/mm/
ddThh:mm:ss.

For example:
<Root MajorVersion="1" MinorVersion="0" CaseId="testCase1" 
Description="XML Export for testCase1 by superuser on 2008-01-
25T14:37:59.400-08:00">

<Batch name= >
</Batch>

Indicates the job ID and file number. 
• name="Job <id>, batch <n>". The job identifier and file number. The file 

number is incremented for each XML file in the export.

For example:
<Batch name="Job 0.5.6.45, batch 1">

<Documents>
</Documents>

Contains one or more <Document> tags that identify each of the exported 
documents.

<Document DocID= 
DocType= MimeType=>
</Document>

Identifies an exported email or loose file and its associated header information, 
files, and locations (one <Document> record per exported email and loose 
file).
• DocID="<n>". Document ID number.

• DocType="<type>". The type of document. The value is Message for emails 
or File for loose files.

• MimeType="<type>". Document MIME type, such as: 
application/msword for Exchange emails and 
application/vnd.ms-outlook for Word files.

For example:
<Document DocID="0.7.10.24132" DocType="Message" 
MimeType="application/vnd.ms-outlook">
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<Tags>
<Tag TagName= 
TagDataType= 
TagValue= />
</Tags>

Specifies the header information for an exported message or loose file.
• TagName="<name>". Name of the header field, such as #From, or #To.

• TagDataType="<type>". Indicates the type of data in the TagValue= field.

• TagValue="<value>". Value of the specified header field.

Message example:
<Tag 

TagName="#From" 
TagDataType="Text" TagValue="Robb, Kathy 
<krobb@hunton.com>" />
<Tag TagName="#To" 
TagDataType="Text" 
TagValue="nyiso_tech_exchange 
<nyiso_tech_exchange@global2000.net>" />
<Tag TagName="#Subject" 
TagDataType="Text" 
TagValue="FW: ICAP WP post" />
<Tag TagName="#DateSent" 
TagDataType="DateTime" 
TagValue="2001-10-04T12:55:32.000-07:00" />
<Tag TagName="#HasAttachments" 
TagDataType="Boolean" 
TagValue="true" />
<Tag TagName="#AttachmentCount" 
TagDataType="Integer" 
TagValue="2" />
<Tag TagName="#AttachmentNames" 
TagDataType="Text" 
TagValue="1.ICAPWG Answers - Strategic 
Energy.doc;image001.jpg" 

/>
Loose file example:
<Tag 

TagName="#FileName" 
TagDataType="Text" 
TagValue="Dortmund" />
<Tag TagName="#FileExtension" 
TagDataType="Text" TagValue="doc" />
<Tag TagName="#FileSize" 
TagDataType="LongInteger" 
TagValue="35328" />
<Tag TagName="#DateModified" TagDataType="DateTime" 
TagValue="2007-11-20T06:59:58.552-08:00" 

/>
Slip sheet indicator example:
<Tag 

TagName="#StartPage" 
TagDataType="Text" 
TagValue="P4-000001" />
<Tag TagName="#EndPage" 
TagDataType="Text" 
TagValue="P4-000001" />
<Tag TagName="#Slipsheet" 
TagDataType="Boolean" 
TagValue="true" />
<Tag TagName="#Language" 
TagDataType="Text" 
TagValue="en" 

/>

Table 6:  XML Export File Formats

Tag Name Description
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<Files>
<File FileType=>
<ExternalFile ... />
</File>
</Files>

Contains the following tags to identify all files exported. For example, if native 
files and extracted text options are included, entries for both the exported 
native files and exported text files are present: 
• FileType="type". Indicates the file type.

• <ExternalFile>.Contains the following tags to identify an exported file:

– FilePath="path". The relative path to the exported native file. This is 
always native because native files are exported to the native subdi-
rectory.

– FileName="<DocID>.<ext>". Indicates the name of the exported file in 
the native subdirectory. The name consists of the document ID and the 
file extension. Note that an email with one or more attachments is 
exported as a single .msg file.

– FileSize="<n>". Number of bytes in the file.

– Hash="<hex>". The MD5-encoded name of the file.

For example:
<Files>

<File FileType="Native">
<ExternalFile FilePath="\clearwell_export_0000001" 
FileName="0.7.15.1414.msg" FileSize="401408" 
Hash="0665cf0fd4b3c63c0ec3aec47d7853ed" />
</File>
<File FileType="Text">
<ExternalFile FilePath="\clearwell_export_0000001" 
FileName="0.7.15.1414.txt" FileSize="2396" 
Hash="8fe7f5f0fd2b07b3c0fd9dcc47d785ed" />
</File>

</Files>

Note:  If the export is a production export, there may also be an “Image” file 
type, if the Image export option is selected and included with the export.

Table 6:  XML Export File Formats

Tag Name Description
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<Reviews>
<Review>
<Tag ... />
</Review>
</Reviews>

Contains a <Tag> record for the latest value of each active tag, and for each 
independent note. This section is included only when tags and notes are 
exported.
• TagName="<name>". Name of the tag or #ReviewComment for a note. A 

tag associated with a folder is followed by the folder name in parentheses.

• TagDataType="<type>". Indicates whether the data is text or a check box 
tag.

• TagValue="<value>". Indicates the tag value or note text. Note text associ-
ated with a specific folder starts with 
(Folder: <name>) (Tag comment). Independent notes do not include a 
folder name.

• ModifiedOn="<time>". Indicates the Date and time the tag was set.

• ModifiedBy="<user>". Indicates the platform’s user who entered the tag.

For example:
<Reviews>
<Review>
<Tag TagName="Reviewed By (FERC Investigation)" 
TagDataType="Text" TagValue="Smith" 
ModifiedOn="2008-02-03T22:03:02.000-08:00" 
ModifiedBy="superuser" />
<Tag TagName="#ReviewComment" TagDataType="Text" 
TagValue="(Project: FERC Investigation) (Tag 
comment) Not relevant" ModifiedOn="2008-02-
03T22:03:02.000-08:00" ModifiedBy="superuser" />

</Review>
</Reviews>

<Locations>
</Locations>

Contains one or more <Location> tags that identify the locations where the 
document was found.

<Location>
<Custodian “<name>”
</Custodian> 
<LocationURI>
</LocationURI>
<LocationID>
</Location>

Contains the following tags to identify a document custodian and location: 
• <Custodian "<name>"</Custodian>. Name of the 

custodian for the document/location combination, if any.

• <LocationURI>. Path used by the system to access the 
document.

• <LocationID>. Uniquely identifies the location of the 
custodian document.

For example:
<Locations>
<Location>
<Custodian />
<LocationURI>esa:file/
*:LooseFiles1:C%3a\BUILDS\DATADIR\DOCFILES
:C%3a\builds\dataDir\DocFiles\prodmgmt\Corbett\PRD\
~$D_Corbett_2006_07_10_R4.doc</LocationURI>

</Location>
</Locations>

Table 6:  XML Export File Formats

Tag Name Description
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XML Summary Files

The following table describes the XML tags, including load file statistics for the Detailed 
Statistics tag, used for the summary file generated for export and print tasks. On print tasks, the 
summary file is not included in the Jobs window unless an error occurs.
 

Table 7:  XML Summary File Formats

Tag Name Description

<summary>
</summary>

The general container for the summary.

XML Export Task

<XML .../> Can contain any of the following tags to identify XML export tasks:
• JobOutputDirectory="<path>"

• TagAndNotes="<#>"

• IncludeNativeFiles="true | false"

• SeparateAttachments="<#>"

• ExportLocations="true | false"

• IncludeDiscussion="true | false"

• IncludeExtendedMetaddata="true | false"

• IncludeExtractedText="true | false"

• ExcludeMetaData="true | false"

• IncludeTiff="true | false"

• IncludePDF="true | false"

• OutputFormat="Configurable Template <#>" | <standard format>

• RemoveEDRMXML="true | false"

• ProductionLabel="<name>"

• ProjectName="<name>"

• Production="<name>"

• LoadFileType="Configurable Template <#>" | <standard format>

• LoadFileFields="<field>"

• LoadFileDateFormat="<date format >"

• LoadFileTimeFormat="<time format>"

• LoadFileSeparateDateAndTime="true | false"

• LoadFileDelimiter="<delimiter type>"

• LoadFileTextQualifier="<qualifier type>"

• LoadFileSeparateCustodianAsRows="true | false"

• LoadFileSeparateTagsAsColumns="true | false"

• LoadFileIncludeFieldNames="true | false"

• LoadFileEncoding="UTF-8 | ISO-8859-1"

• LoadFileIncludeBatchID="true | false"

• LoadFileIncludeProjects="true | false"

• LoadFileIncludeOpticon="true | false"
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• LoadFileIncludeOpticon="true | false"

• SeparateEmbeddings="true | false"

• MaxFileSize="<#>"

• Description="<text>". (Number of documents selected and the search criteria used to 
find them.)

• summaryFile="<name>". (Always named: summary.xml).

For example:
<XML 

JobOutputDirectory="C:\dev\data\ExportOutputDir" 
summaryFile="summary.xml" 
IncludeTagsAndComments="true" 
IncludeNativeFiles="true" 
Description="4 documents (selected by user) from search 
Entire Corpus"

/>

<SummaryStats .../> Contains the following summary statistics:
• TotalMsgsSelectedForExport="n". Number of documents selected for export.

• TotalMsgsWithLocatorsExpanded="n". Number of documents selected for export, 
including duplicates.

• TotalErrors="n". Number of documents that were not included (see the file recover-
able_urn.xml for details).

For example:
<SummaryStats 

TotalMsgsSelectedForExport="4" 
TotalMsgsWithLocatorsExpanded="213" 
TotalErrors="208"

/>

Native Export Task

<Native .../> Contains the following tags to identify a Native export task:
• JobOutputDirectory="<path>". Directory on the 

appliance that contains the output for the task.

• recoveryFile="<name>". Name of the file that describes any errors that occurred 
(always recoverable_urn.xml).

• summaryFile="<name>". Name of the summary file (always 
summary.xml).

• OutputFile="<text>". Indicates whether a separate PST file is 
generated for each mailbox.

• PreserveFolders="true | false". Indicates whether mailbox folder structure is pre-
served.

• PreserveIfFlatten="true | false".

• SuppressFullSourceFPath="true | false".

• DeDupByCustodian="true | false". Indicates whether duplicate documents are 
excluded by custodian, rather than across the entire export.

• Password-Protect-Files="true | false". Indicates whether a 
password is required to open the exported files.

Table 7:  XML Summary File Formats

Tag Name Description
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• Format="<format type>".

• ProductionLabel="<name>".

• ProjectName="<name>".

• Description="<text>". Indicates the number of documents selected and the search 
criteria used to find them.

For example:
<Native
JobOutputDirectory="C:\dev\data\jsmith\ExportOutputDir" 
recoveryFile="recoverable_urn.xml" 
summaryFile="summary.xml" 
OutputFile="One PST for all mailboxes" 
PreserveFolders="true" 
PreserveIfFlatten="true"
SuppressFullSourcePath="false"
DeDupByCustodian="false" 
Password-Protect-Files="false" 
Format="OUTLOOK2003/2007" 
ProductionLabel="clearwell_export"
ProjectName="Prod1"
Description="All documents (selected by user) from search 
([Productions / Prod1])" 

/>

<DetailedStats .../> Contains the following detailed statistics:
• MsgUniqueTotal="n". Number of non-NSF emails selected for export.

• MsgUniqueErrTotal="n". Number of non-NSF emails that were not included.

• MsgUnavailableTotal="n". Number of non-NSF emails that were not available.

• MsgExtractionErrTotal="n". Number of non-NSF emails that were not extracted.

• NSFUniqueTotal="n". Number of NSF emails selected for export.

• NSFUniqueErrTotal="n". Number of NSF emails that were not included.

• NSFUnavailableTotal="n". Number of NSF emails that were not available.

• NSFExtractionErrTotal="n".Number of NSF emails that were not extracted

• LooseFilesUniqueTotal="n". Number of loose files selected for export.

• LooseFilesUniqueErrTotal="n". Number of loose files that were not included.

• LooseFilesUnavailableTotal="n". Number of loose files that were not available.

• LooseFilesExtractionErrTotal="n". Number of loose files that were not extracted.

• AttachmentTotal="n". Number of attachments selected for export.

• AttachmentFailErrTotal="n". Number of attachments that were not included.

• AttachmentExtractionErrTotal="n". Number of attachments that were not extracted.

• PSTUniqueTotal="n". Number of emails selected for export to PST file(s).

• PSTDuplicateTotal="n". Number of duplicates selected for export to PST file(s).

• PSTUniqueErrTotal="n". Number of emails that were not included.

• PSTDuplicateErrTotal="n". Number of copies that were not included, although at 
least one copy was exported to PST file(s).

• PSTUnavailableTotal="n". Number of emails that were not available.

Table 7:  XML Summary File Formats

Tag Name Description
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• ServerUniqueTotal="n". Number of documents selected for export to the server.

• ServerDuplicateTotal="n". Number of duplicates exported to the server.

• ServerUniqueErrTotal="n". Number of documents that were not included for export 
to the server.

• ServerDuplicateErrTotal="n". Number of copies that were not included, although at 
least one copy was exported to the server.

• EmailFileUniqueTotal="n". Number of emails selected for export.

• EmailFileDuplicateTotal="n". Number of duplicates selected for export.

• EmailFileUniqueErrTotal="n". Number of emails that were not included.

• EmailFileDuplicateErrTotal="n". Number of copies that were not included, although 
at least one copy was exported.

• EmailFileUnavailableTotal="n". Number of emails that were not available.

• NSFUniqueTotal="n". Number of emails selected for export to NSF.

• NSFDuplicateTotal="n". Number of duplicates selected for export to NSF.

• NSFUniqueErrTotal="n". Number of emails that were not included.

• NSFDuplicateErrTotal="n". Number of copies that were not included, although at 
least one copy was exported to NSF.

• NSFUnavailableTotal="n". Number of emails that were not available.

• LooseFilesUniqueTotal="n". Number of loose files selected for export.

• LooseFilesDuplicateTotal="n". Number of duplicate loose files selected for export.

• LooseFilesUniqueErrTotal="n". Number of loose files that were not included.

• LooseFilesDuplicateErrTotal="n". Number of copies that were not included, 
although at least one copy was exported.

• LooseFilesUnavailableTotal="n". Number of loose files that were not available.

• MsgUniqueTotal="n". Number of emails selected for printing.

• MsgUniqueErrTotal="n". Number of emails that were not included.

• LooseFilesUniqueTotal="n". Number of loose files selected for printing.

• LooseFilesUniqueErrTotal="n". Number of loose files that were not included.

• AttachmentTotal="n". Number of attachments selected for printing.

• AttachmentFailErrTotal="n". Number of attachments that were not included.

The following statistics apply specifically to data imported from load files:
• LoadFileMsgNativeUnavailableTotal="n". Total number of unavailable documents 

in native form. 

• LoadFileAttachmentNativeUnavailableTotal="n". Total number of unavailable 
native attachments in native form. 

• LoadFileLooseFileNativeUnavailableTotal="n". Total number of unavailable loose 
files in native form. Specific to the documents imported using load files.

• LoadFileMsgTextUnavailableTotal="n". Total number of unavailable documents in 
text form. 

• LoadFileAttachmentTextUnavailableTotal="n". Total number of unavailable attach-
ments in text form. 

• LoadFileLooseFileTextUnavailableTotal="n". Total number of unavailable loose files 
in text form.

Table 7:  XML Summary File Formats
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For example:
<DetailedStats 

MsgUniqueTotal="259" 
MsgUniqueErrTotal="0" 
MsgUnavailableTotal="0"
MsgExtractionErrTotal="0"
NSFUniqueTotal="0" 
NSFUniqueErrTotal="0" 
NSFUnavailableTotal="0"
NSFExtractionErrTotal="0"
LooseFilesUniqueTotal="3" 
LooseFilesUniqueErrTotal="0"
LooseFilesUnavailableTotal="0"
LooseFilesExtractionErrTotal="0"
AttachmentTotal="0"
AttachmentFailErrTotal="0"
AttachmentExtractionErrTotal="0"
PSTUniqueTotal="70" 
PSTDuplicateTotal="132" 
PSTUniqueErrTotal="70" 
PSTDuplicateErrTotal="132"
PSTUnavailableTotal="0"
ServerUniqueTotal="0"
ServerDuplicateTotal="0"
ServerUniqueErrTotal="0"
ServerDuplicateErrTotal="0"
EmailFileUniqueTotal="0"
EmailFileDuplicateTotal="0"
EmailFileUniqueErrTotal="0"
EmailFileDuplicateErrTotal="0"
EmailFileUnavailableTotal="0"
NSFUniqueTotal="6"
NSFDuplicateTotal="0"
NSFUniqueErrTotal="6"
NSFDuplicateErrTotal="0"
NSFUnavailableTotal="0"
LooseFilesUniqueTotal="5" 
LooseFilesDuplicateTotal="0" LooseFilesUniqueErrTotal="0"
LooseFilesDuplicateErrTotal="0"
LooseFilesUnavailableTotal="0"
MsgUniqueTotal="10" 
MsgUniqueErrTotal="2" 
LooseFilesUniqueTotal="0" 
LooseFilesUniqueErrTotal="0" 
AttachmentTotal="0"
AttachmentFailErrTotal="0"
LoadFileMsgNativeUnavailableTotal="0" 
LoadFileAttachmentNativeUnavailableTotal="0"
LoadFileLooseFileNativeUnavailableTotal="0"
LoadFileMsgTextUnavailableTotal="0" 
LoadFileAttachmentTextUnavailableTotal="0" 
LoadFileLooseFileTextUnavailableTotal="0"

/>

Table 7:  XML Summary File Formats
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Print Task

<Print .../> Contains the following tags to identify a print task:
• JobOutputDirectory="<path>". Directory on the 

appliance that contains the output for the task.

• recoveryFile="<name>". Name of the file that describes any errors that occurred 
(always recoverable_urn.xml).

• summaryFile="<name>". Name of the summary file (always 
summary.xml).

• IncludeTagsAndComments="y | n". Indicates whether tags and comments are 
included.

• IncludeFilesAndAttachments="y | n". Indicates whether native files are included.

• IncludeDocumentIDs="y | n". Indicates whether document identification numbers 
are included.

• IncludeLocations="y | n". Indicates whether file locations are included.

• ProductionLabel="<text>". Name of production to be included.

• ProjectName="<text>". Name of the project.

• Description="<text>". Indicates the number of documents selected and the search 
criteria used to find them.

For example:
<PDF

JobOutputDirectory="C:\dev\data\jsmith\ExportOutputDir" 
recoveryFile="recoverable_urn.xml" 
summaryFile="summary.xml" 
IncludeTagsAndComments="y" IncludeFilesAndAttachments="n" 
IncludeDocumentIDs="y" 
IncludeLocations="n" 
ProductionLabel="clearwell_export"
ProjectName="Prod1"
Description="All documents (all search results) from search 
Entire Corpus" 

/>

Table 7:  XML Summary File Formats

Tag Name Description
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Extended Metadata Summary

The following table provides a consolidated view of all metadata exported from the platform for 
the various report and export options. 

The Metadata Field Summary table includes the following information:

• Field—Type of metadata

• Source—How the metadata is generated

• Description—Description of the item

• XML Location— Location in the XML file where the field can be found. For example, 
“Document/@DocID” means that the value can be found in the <Document> record with 
the name “DocID” (for example, <Document DocID=”0.7.1.94983”>).

You can use the syntax directly in an XML transform to return the desired field value. 
For example, to include the subject metadata field in a transform: 
(“Tags/Tag[@TagName="#Subject"]/@TagValue” in the table) from the context 
of a <Document> record, in your transform file, you would include the expression: 
<xsl:value-of select="(Tags/Tag[@TagName='#Subject']/@TagValue)"/> 

• Metadata Field: XML (standard) or XML (extended)—Whether field is included in XML 
exports: Standard metadata field (included in all XML exports) or an Extended metadata 
field (included only in XML exports where Include extended metadata is selected).

• Document Log—Whether the field is included in the Document log (generated from the 
Print reporting menu option rather than the Export option). (Sometimes preferred over 
using XML export to generate metadata output).
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Table 8:  Metadata Field Summary

Field Description

Doc ID System-generated. The unique document ID that the system assigns to each document, in 
“dot-notation” format

XML Location: Document/@DocID

Metadata Field: XML Standard

Document Log: Yes (“Document ID” column)

Doc Type

System-generated. Classification of the document as either “Message” or “File” (note that 
in some cases, as with multipart MIME, .msg, or .eml files, the system may classify email 
files as File, not Message). 

XML Location: Document/@DocID

Metadata Field: XML Standard

Document Log: No

Language

System-generated (No).The primary language of the document, in ISO 639-1 format (e.g. 
"en" for English)

XML Location: Tags/Tag[@TagName="#Language"]/@TagValue

Metadata Field: XML Standard

Document Log: No

Mime Type

System-generated. For Outlook messages, the system uses “application/vnd.ms-outlook”, 
and for Lotus Notes messages the system uses “application/vnd.lotus-notes”. For files, the 
system uses Stellent classification of the MIME type of the document. 

XML Location: Document/@DocID

Metadata Field: XML Standard

Document Log: No

Subject

From email content or file content. If email, This is the subject line of the 
document. If file, field is populated with the Subject metadata extracted 
from Microsoft Office files.

XML Location: Tags/Tag[@TagName=”#Subject”]/@TagValue

Metadata Field: XML Standard

Document Log: Yes

From

From email content. The sender of the document, if it is an email. For files, this is left blank.

XML Location: Tags/Tag[@TagName=”#Subject”]/@TagValue

Metadata Field: XML Standard

Document Log: Yes



 PAGE: 66

To

From email content. The recipient(s) of the document, if it is an email. If it is a 
file, this is left blank. 

XML Location: Tags/Tag[@TagName=”#To”]/@TagValue 

Metadata Field: XML Standard

Document Log: Yes

CC

From email content. The cc’ed recipients of the document, if it is an email. If 
it is a file, this is left blank. 

XML Location: Tags/Tag[@TagName=”#CC”]/@TagValue

Metadata Field: XML Standard

Document Log: Yes

BCC

From email content. The bcc'ed recipients of the document, if it is an email. If 
it is a file, this is left blank. 

XML Location: Tags/Tag[@TagName=”#BCC”]/@TagValue

Metadata Field: XML Standard

Document Log: Yes

Date Sent

From email content. The sent date of the email. If it is a file, this is left blank. 

XML Location: Tags/Tag[@TagName=”#DateSent”]/@TagValue

Metadata Field: XML Standard

Document Log: Yes (“Date” column)

Has Attachments?

From email content, “true” if the email has attachments, else “false”. If it's a 
file, this is left blank. 

XML Location: Tags/Tag[@TagName=”#HasAttachments”]/@TagValue

Metadata Field: XML Standard

Document Log: No

Attachment Count

From email content. The number of atttachments if HasAttachments is 
“true”, else blank. 

XML Location: Tags/Tag[@TagName=”#AttachmentCount”]/@TagValue

Metadata Field: XML Standard

Document Log: No

Attachment 
Names

From email content. A semicolon-delimited list of attachment names if 
HasAttachments is “true”, else blank. 

XML Location: Tags/Tag[@TagName=”#AttachmentNames”]/
@TagValue 

Metadata Field: XML Standard

Document Log: Yes (“Attachments” column)

Table 8:  Metadata Field Summary

Field Description
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Date Received 

From email content. The date the email was received.

XML Location: Tags/Tag[@TagName=”#DateReceived”]/@TagValue

Metadata Field: XML Standard

Document Log: No

Flags

From file content. Whether the document contains content that was 
embedded, hidden, a comment, or processed with Optical Character 
Recognition (OCR) software.

XML Location: CustomDocumentInfo/Flags/Flag

Metadata Field: XML Standard

Document Log: No

Values: EmbeddedObjects, HiddenContent, Comments, 
HiddenCells, NoIndexedText, etc.

Read Flag

From email content. Whether the email was read or not.

XML Location: Tags/Tag[@TagName=”#ReadFlag”]/@TagValue

Metadata Field: XML Standard

Document Log: No

Importance Flag

From email content. Whether or not the message was sent with high 
importance (if not normal).

XML Location: Tags/Tag[@TagName=”#ImportanceFlag”]/@TagValue

Metadata Field: XML Standard

Document Log: No

Message Class

From email content. The class of the message (currently, “Message”, 
“Contact”, or “Calendar”). 

XML Location: Tags/Tag[@TagName=”#MessageClass”]/@TagValue

Metadata Field: XML Standard

Document Log: No

Flag Status

From email content. The flag status of the message. Valid values are 
“NoFlag” or “FlagMarked.” 

XML Location: Tags/Tag[@TagName=”#FlagStatus”]/@TagValue

Metadata Field: XML Standard

Document Log: No

Table 8:  Metadata Field Summary

Field Description
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Priority

From email content. The priority of the message. Valid values are “Normal”, 
“Urgent”, and “Nonurgent.” 

XML Location: Tags/Tag[@TagName=”Priority”]/@TagValue

Metadata Field: XML Standard

Document Log: No

Sensitivity

 From email content. The sensitivity of the message. Valid values are “None”, 
“Personal”, “Private”, and “Company Confidential.” 

XML Location: Tags/Tag[@TagName=”Sensitivity”]/@TagValue

Metadata Field: XML Standard

Document Log: No

Read Receipt

From email content. Whether or not a read receipt was requested. 

XML Location: Tags/Tag[@TagName=”ReadReceipt”]/@TagValue

Metadata Field: XML Standard

Document Log: No

Mood

From email content. The mood of the message (Lotus Notes only). Valid 
values are “Normal”, “Personal”, “Private”, “Confidential”, “Thank You!”, “Flame”, 
“Good Job”, “Joke”, “FYI”, “Question”, and “Reminder.” 

XML Location: Tags/Tag[@TagName=”Mood”]/@TagValue

Metadata Field: XML Standard

Document Log: No

File Name

From file system. The name of the file if the document is a file, without 
extension. If it is an email, this is left blank. 

XML Location: Tags/Tag[@TagName="#FileName"]/@TagValue

Metadata Field: XML Standard

Document Log: Yes (“Subject” column, includes extension)

File Extension

From file system. The extension of the file if the document is a file. If it is an 
email, this is left blank. 

XML Location: Tags/Tag[@TagName="#FileExtension"]/@TagValue

Metadata Field: XML Standard

Document Log: No

Table 8:  Metadata Field Summary
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File Size

From file system 

The size of the file if the document is a file. If it is an email, this is left blank. 

XML Location: Tags/Tag[@TagName="#FileSize"]/@TagValue

Metadata Field: XML Standard

Document Log: No

Date Created

From file system.

The creation date of the file if the document is a file. If it is an email, this is 
left blank. 

For loose files, this should always be populated with an accurate value 
reflecting the creation date of the file as it exists at the document source 
when the system performs the export. 

For attachments, the platform attempts to get the value through MAPI. Note 
that in some cases a creation date is not available for an attachment; in this 
situation it will be either blank or alternatively set to 1601-01-01T00:00:00 
GMT. 

XML Location: Tags/Tag[@TagName="#DateCreated"]/@TagValue

Metadata Field: XML Standard

Document Log: No

Date Accessed

From file system. The last accessed date of the file if the document is a file. If 
it is an email or attachment, this is left blank (attachments don't have a 
DateAccessed MAPI property stored). 

XML Location: Tags/Tag[@TagName="#DateAccessed”]/@TagValue

Metadata Field: XML Standard

Document Log: No

Date Modified

From file system. 

The last modified date of the file if the document is a file. If it is an email, this 
is left blank. 

For loose files, this should always be populated with an accurate value 
reflecting the last modified date of the file as it exists at the document 
source when the system performs the export. 

For attachments, the system attempts to get the value through MAPI. Note 
that in some cases a last modified date is not available for an attachment; in 
this situation it will be either blank or alternatively set to 1601-01-
01T00:00:00 GMT. 

XML Location: Tags/Tag[@TagName=”#DateModified”]/@TagValue

Metadata Field: XML Standard

Document Log: Yes (“Date” column) 

Table 8:  Metadata Field Summary
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Date Printed

From file content. The last print date of the file if the document is a file. If it 
ian email, this is left blank. 

XML Location: Tags/Tag[@TagName=”#DatePrinted”]/@TagValue

Metadata Field: XML Extended

Document Log: No

Title

From file content. The title of the document (MS Office docs only). 

XML Location: Tags/Tag[@TagName=”#Title”]/@TagValue

Metadata Field: XML Extended

Document Log: No

Subject

From file content. The subject of the document (MS Office docs only). 

XML Location: Tags/Tag[@TagName=”#Subject”]/@TagValue

Metadata Field: XML Extended

Document Log: No

Author

From file content. The author of the document (MS Office docs only). 

XML Location: Tags/Tag[@TagName="#Author”]/@TagValue

Metadata Field: XML Extended

Document Log: No

Company

From file content. Company (MS Office docs only). 

XML Location: Tags/Tag[@TagName=”#Company”]/@TagValue

Metadata Field: XML Extended

Document Log: No

Category

From file content. Category (MS Office docs only). 

XML Location: Tags/Tag[@TagName="#Category”]/@TagValue

Metadata Field: XML Extended

Document Log: No

Keywords

From file content. Keywords (MS Office docs only). 

XML Location: Tags/Tag[@TagName="#Keywords”]/@TagValue

Metadata Field: XML Extended

Document Log: No

Comments

From file content. Comments (MS Office docs only). 

XML Location: Tags/Tag[@TagName="#Comments”]/@TagValue

Metadata Field: XML Extended

Document Log: No

Table 8:  Metadata Field Summary

Field Description
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Creation Date

 From file content. 

The create date of the file from the internal file metadata (MS Office docs 
only). This is the same date that is visible as “creation date” in the trailing 
metadata section of the platform’s (Outside In) HTML view if that property is 
enabled. It may or may not match with the file system creation date 
(#DateCreated). 

XML Location: Tags/Tag[@TagName=”CreationDate”]/@TagValue

Metadata Field: XML Extended

Document Log: No

Last Save Date

From file content. 

The last save date of the file from the internal file metadata (MS Office docs 
only). This is the same date that is visible as “Last Saved Date” (generally) in 
the trailing metadata section of the system (Outside In) HTML view if that 
property is enabled. It may or may not match with the file system creation 
date (#DateModified). 

XML Location: Tags/Tag[@TagName="LastSaveDate”]/@TagValue

Metadata Field: XML Extended

Document Log: No

Last Saved By

From file content. Who last saved the file (MS Office docs only). 

XML Location: Tags/Tag[@TagName="LastSavedBy"]/@TagValue

Metadata Field: XML Extended

Document Log: No

Source

From file content. The document source (MS Office docs only). Usually the 
name of the application, such as “Microsoft Office Word.” 

XML Location: Tags/Tag[@TagName="#Source”]/@TagValue

Metadata Field: XML Extended

Document Log: No

Page Count

From file content (MS Office docs only). 

XML Location: Tags/Tag[@TagName=”PageCount”]/@TagValue

Metadata Field: XML Extended

Document Log: No

Word Count

From file content. Word count (MS Office docs only). 

XML Location: Tags/Tag[@TagName=”WordCount”]/@TagValue

Metadata Field: XML Extended

Document Log: No

Table 8:  Metadata Field Summary
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Character Count

From file content. Number of characters in the document (MS Office docs 
only). 

XML Location: Tags/Tag[@TagName=”CharCount”]/@TagValue

Metadata Field: XML Extended

Document Log: No

Revision Number

 From file content. Revision number (MS Office docs only). 

XML Location: Tags/Tag[@TagName=”RevisionNumber”]/@TagValue

Metadata Field: XML Extended

Document Log: No

Edit Minutes

From file content. Total minutes spent editing the file (MS Office docs only). 

XML Location: Tags/Tag[@TagName=”EditMinutes”]/@TagValue

Metadata Field: XML Extended

Document Log: No

Slide Count

From file content. Total number of slides (MS PowerPoint only). 

XML Location: Tags/Tag[@TagName=”SlideCount”]/@TagValue

Metadata Field: XML Extended

Document Log: No

Hidden Slide 
Count

From file content. Number of hidden slides (MS PowerPoint docs only). 

XML Location: Tags/Tag[@TagName=”HiddenSlideCount”]/@TagValue

Metadata Field: XML Extended

Document Log: No

Multimedia Clip 
Count

From file content. Number of multimedia clips (MS PowerPoint docs only). 

XML Location: Tags/Tag[@TagName=”MultimediaClipCount”]/@TagValue

Metadata Field: XML Extended

Document Log: No

Slide Note Count

From file content. Number of slides with notes (MS PowerPoint docs only). 

XML Location: Tags/Tag[@TagName=”SlideNoteCount”]/@TagValue

Metadata Field: XML Extended

Document Log: No

Table 8:  Metadata Field Summary
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Native Export File 
Path

System-generated. The path of the file (in the format “<DocID>.<File 
extension>”), if native files were included in the export. 

XML Location: Files/File[@FileType=”Native”]/ExternalFile/@FilePath

Metadata Field: XML Standard

CSV Report: No

Native Export File 
Name

System-generated. The name of the file (in the format “<DocID>.<File 
extension>”), if native files were included in the export. 

XML Location: Files/File[@FileType=”Native”]/ExternalFile/@FileName

Metadata Field: XML Standard

Document Log: No

Native Export File 
Size

System-generated. The size of the exported file, if native files were included 
in the export. 

XML Location: Files/File[@FileType=”Native”]/ExternalFile/@FileSize

Metadata Field: XML Standard

Document Log: No

Native File Export 
Hash

System-generated. The calculated MD5 hash of the exported file, if native 
files were included in the export. 

XML Location: Files/File[@FileType=”Native”]/ExternalFile/@Hash

Metadata Field: XML Standard

Document Log: No

Extracted Text File 
Path/Name/Size/
Hash

System-generated. Parallels the native file information, the path, name, size, 
and hash of the extract text file if included in the export. 

XML Location: Files/File[@FileType=”Text”]/ExternalFile/
{@FilePath,@FileNane,@FileSize,@Hash}

Metadata Field: XML Standard (if user chooses to include extracted text)

Document Log: No

Redacted File 
Path/Name/Size/
Hash

System-generated. Parallels the native file information (the path, name, size, 
and hash of the produced file if it was redacted and images were included in 
the production export in TIFF or PDF format).

XML Location: Files/File[@FileType='Redacted']/ExternalFile/
{@FilePath,@FileNane,@FileSize,@Hash}

Metadata Field: XML Standard (if user chooses to include images)

Document Log: No

Table 8:  Metadata Field Summary
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Image File Path/
Name/Size/Hash

System-generated. Parallels the native file information (the path, name, size, 
and hash for a produced file if it was not redacted and images were included 
in the production export in TIFF format). 

XML Location: Files/File[@FileType='Image']/ExternalFile/
{@FilePath,@FileNane,@FileSize,@Hash}

Metadata Field: XML Standard (if user chooses to include images)

Document Log: No

PDF File Path/
Name/Size/Hash

System-generated. Parallels the native file information (the path, name, size, 
and hash for a produced file if it was not redacted and images were included 
in the production export in PDF format). 

XML Location: Files/File[@FileType='PDF']/ExternalFile/
{@FilePath,@FileNane,@FileSize,@Hash} 

Metadata Field: XML Standard (if user chooses to include images)

Document Log: No

Custodians

User-generated. The custodian(s) associated with the document. 

XML Location: Locations/Location/Custodian

Metadata Field: XML Standard

Document Log: Yes (“Custodian 1...<n>” columns; max <n> set by property)

Location(s)

System-generated. The original location(s) where the document was found. 

XML Location: Locations/Location/LocationURI 

Metadata Field: XML Standard

Document Log: Yes (“Document Source 1...<n>” columns; max <n> set 
by property)

Table 8:  Metadata Field Summary
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Tags

User-generated. The user-supplied tag(s) associated with the document 
(including tag comments and document notes). 

XML Locations: Checkbox tags:
• TagName should start with [TagSetName] and continue down the 

tree adding [Label:TagValueName] for each level in the tree, sepa-
rated by the colon delimiter “:”

• TagValue = ”yes”

• TagDataType = Boolean

Radio Buttons and drop-down tags:
• TagName should start with [TagSetName] and continue down the 

tree adding [Label:TagValueName] for each level in the tree, sepa-
rated by the colon delimiter “:”

• TagValue = the final [TagValueName] in the tree

• TagDataType = Text

Comments:
• TagName should start with [TagSetName] and continue down the 

tree adding [Label:TagValueName] for each level in the tree, sepa-
rated by the colon delimiter “:”

• TagValue = comment text

• TagDataType = LongText

Metadata Field: XML Standard (if user chooses to include tags)

Document Log: Yes (individual columns named by tag name, “Tagged” used for 
boolean to indicate it's tagged)

Projects

User-generated. The user-supplied folder(s) associated with the document. 
These are actually stored in the XML in the reverse manner -- the set of 
documents that are in a given folder. 

XML Location: Folders/Folder/@FolderName (Documents contained inside the 
<Folder> record)

Metadata Field: XML Standard

Document Log: Yes (individual columns named “Project: <folder_name>”) 

Discussion Thread 
ID

System-generated. The discussion thread ID of the email. This is always 
blank for loose files and for emails that were not part of a discussion thread. 

XML Location: CustomDocumentInfo/ThreadID

Metadata Field: XML Standard

Document Log: No

Table 8:  Metadata Field Summary
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Error

System-generated. Reason for processing error.

XML Location: CustomDocumentInfo/Error/Reason

Metadata Field: XML Standard

Document Log: No

Values: Encrypted Message, etc

Batch ID(s)

System- and user-generated. The batch ID(s) of any processing or 
production batches this document has been associated with (not including 
the export which created the XML file, since the batch is only formally 
created on official completion of the export). 

XML Location: CustomDocumentInfo/Batches/BatchId

Metadata Field: XML Standard

Document Log: No

Strict checksum

System-generated. The “strict checksum” that the system used to help 
determine whether the document was a duplicate. 

CLEARWELL SUPPORT USE ONLY. 

XML Location: CustomDocumentInfo/StrictChecksum

Metadata Field: XML Standard

Document Log: No

Relaxed checksum

System-generated. The “relaxed checksum” that the system used to help 
determine if the document was a duplicate while determining whether the 
document was a part of a conversation thread. 

CLEARWELL SUPPORT USE ONLY. 

XML Location: CustomDocumentInfo/RelaxedChecksum

Metadata Field: XML Standard

Document Log: No

Crawler checksum

System-generated. The checksum that the system crawler computed when 
initially processing the document. 

CLEARWELL SUPPORT USE ONLY. 

XML Location: CustomDocumentInfo/CrawlerChecksum

Metadata Field: XML Standard

Document Log: No

Table 8:  Metadata Field Summary
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Start page

Production Export Only

System-generated (No). The starting page of the produced version of the 
document.

XML Location: Tags/Tag[@TagName="#StartPage"]/@TagValue

Metadata Field: XML Standard

Document Log: No

End page

Production Export Only

System-generated (No). The ending page of the produced version of the 
document (if native production, then same as start page).

XML Location: Tags/Tag[@TagName="#EndPage"]/@TagValue

Metadata Field: XML Standard

Document Log: No

Table 8:  Metadata Field Summary

Field Description



 PAGE: 78



   PAGE: 79

Export and Production GuideRunning Productions
This section describes how to prepare for and successfully run productions of documents. 

Note:  You must have the appropriate user role, and have a licensed Review, Redaction, and 
Production module to create and run productions on your appliance. For more information on 
user roles and their associated privileges, see “Case Administration Guide: Case Administration 
Overview”.

Refer to the following topics in this section:

• “Production Overview” in the next section

– “Production Process Workflow” on page 80

• “Production Best Practices” on page 81

• “Production Considerations” on page 81

• “Production Stages” on page 83

– “Running a Production” on page 84

– “Considerations” on page 84

– “Reviewing a Production” on page 86

– “Unlock and Unproduce a Production Folder (Optional)” on page 87

• “Performing Production Exports” on page 88
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Production Overview
Production is the stage in the eDiscovery process in which documents are prepared for delivery 
to a requesting party. Typically, it occurs after documents have been preserved, collected, 
processed and reviewed. The goal is to prepare and produce documents in a usable format that 
complies with agreed upon production requirements.

Production Process Workflow

Prerequisite Workflow

Before you start the Production process, make sure you perform the following tasks on your 
data set:

• Identify documents of interest

• Cache documents (for quicker results)

• Review and redact documents based on your output requirements

To produce documents

The system’s document production occurs in the following stages:

1. Create a Production Folder

A. Select documents that you want to produce
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B. Choose folder options

2. Copy or move documents the Production Folder

Note:   You can move or copy documents in two ways: (1) Using the Action menu in Review 
mode or (2) Using the bulk tagging window (refer to "Bulk Tagging Reviewable Items" in the 
Veritas eDiscovery PlatformVeritas eDiscovery Platform User’s GuideUser Guide). 

3. Verify Production Options

4. Run the production by choosing Lock/Produce on the folder

5. Monitor Progress by clicking the production folder’s Refresh button or tracking the 
production job progress in the Jobs window or Jobs page.

6. Review the production in Review mode (Refer to "Linear Review Tools in Review Mode" in the 
User Guide.)

7. If necessary, preview, fix problems and re-produce

8. Export the produced documents from Review mode. For more information, see “Export 
Process Workflow” on page 13. 

Production Best Practices
When you prepare a set of documents for production, consider the following “checklist” items 
to help you select the appropriate options and ensure your production job will be successful:

• Check the content of your document set. 

• Check your output requirements for items. One area to evaluate and consider is how to 
handle potential problem files (such as delegated messages, or attachments) and image 
files. For more information, see “Viewing Production Slip Sheet Reports” on page 102.

• Check production export requirements. See “Performing Production Exports” on page 88.

Production Considerations
• When generating a production document, the system automatically scales down the 

original page. This allows the specified header and footer to be displayed without 
encroaching on the original document content. This is the case for all document types, 
including TIFFs. 

For example, if you have processed an already-numbered TIFF into the system, both the 
original TIFF production number and the system-generated production number are shown. 
The system -generated production number is located at the top of the page and the 
original TIFF production number is displayed in the TIFF region of the page.
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• Slipsheet Report search filter is unavailable for locked production folders. When a 
production folder is unlocked after the case is upgraded and the Break out embeddings 
as separate items option is not selected, then the production folder is locked again. The 
slipsheet report is generated when the production folder is locked. To generate this 
information after the case is upgraded, unlock and re-lock the production.
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Production Stages
Production prepares documents for delivery to a requesting party. 

Document production occurs in the following stages: 

1. Folder creation

To produce a set of documents, the documents must be copied into a production folder. 
(To set up production folders, refer to “Setting Up Production Folders” in the Case 
Administration Guide.) 

2. Document selection 

Select the documents that you want to produce and copy or move them to a production 
folder. You can move or copy documents in either of the following ways:

– Use the Action menu in Review mode, as described in "Using the Document Review 
Screen" in the User Guide.

– Use the tagging window, as described in "Bulk Tagging Reviewable Items" in the Veritas 
eDiscovery PlatformVeritas eDiscovery Platform User’s GuideUser Guide. 

3. Production 

– Decide what kind of production you want to run: Images, Native, and Mixed Mode. 

– To produce the set of documents, follow the steps outlined in “Running a Production” in 
the next section.

4. Production Review

Review the production in Review mode, as described in "Using the Document Review Screen" 
in the User Guide.

5. Production Export

Export the produced documents from Review mode, as described in “Performing Production 
Exports” on page 88.
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Running a Production

There are three options for production: Images, Native, and Mixed-mode. 

When Image production is chosen, all documents are imaged which can then be delivered to 
the requesting party. Each page in the document that is imaged will have a unique bates 
number. For Native productions, documents are produced in their Native format as opposed to 
getting imaged. There is one bates number generated per document (as opposed to each page 
within the document). 

Mixed-mode productions enable you to choose the file types that you want produced as images 
and those you want produced in their native format. Mixed-mode productions become useful 
under the following conditions:

1. A majority of files need to be produced as TIFFs (images)

2. Preference to produce Excel spreadsheets and PowerPoint slides natively because they are 
fairly complex to render as TIFFs. Another noteworthy consideration is that slides that 
contain notes or excel formulas would not otherwise be captured.

You can run multiple production jobs simultaneously. These production jobs run until they 
complete enabling you to start a production job and run it overnight without needing to 
monitor the jobs status. If the job fails, it is restarted. 

Considerations

Reports

Depending on production requirements, you may want to add a confidentiality footer for 
printed reports.

To configure the confidentiality footer for printed reports

1. From the All Cases view, click the System > Settings > Export/Print tab.

2. Type the new confidentiality footer text in the field provided.
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To run a production

1. On the top navigation bar, within a selected case, click Case Home > Folders. 

2. Select the production in the Production folder and click Edit from the Actions menu.

3. Verify the production folder settings are set correctly.

For information about production settings, see "Setting Up Folders" in the Case 
Administration Guide.

4. Click Lock/Produce. 

Selecting and Running a Production Folder

This produces the documents and locks the folder so that no more documents can be 
added to the folder. 

5. After the production is finished running, the document is available for viewing in Review 
mode prior to export. From Review mode, click Productions and select the name of the 
production folder.
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Reviewing a Production

After you create a production, review the documents to verify everything displays accurately:

To view production statistics

1. From the Analysis & Review module, click the drop-down showing “All Documents” 
(default).

2. Select the Productions folder, then click Edit from the Actions menu.

3. From the Production window, click the Production tab. The current production statistics 
display. 

4. If the production is still running, click Refresh to refresh production statistics. Refreshing 
the statistics enables you to get an early view of any potential problems in the production 
by viewing the statistics for the number of slip sheets produced, for example.

To review a production

1. From the Analysis & Review module, select the production folder to review from the folder 
menu. Click Go. The produced documents display in List view with their production 
number displayed.

Note:   You can sort documents based on their production numbers.

2. Click the Review Mode icon to go to Review Mode.

3. From the View menu, click Production and select the production folder you want to 
review.

The documents display.

4. Verify the following:

– Headers and footers display the correct information and are positioned appropriately.

– Redactions display properly.

– Production numbering is accurate. By default, production numbers for documents and 
their attachments display in the header.
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Unlock and Unproduce a Production Folder (Optional)

Production folders can be unlocked and unproduced after the produced folder has been 
exported. This enables you to remove privileged documents that were inadvertently included in 
the original production, and then produce a new set of documents using the original 
production numbers. 

Note:  Use caution when unlocking a Production folder after export. Doing so may be 
problematic since each document in the production set already has an assigned individual 
production number from when it was originally locked and produced.

You can unlock and unproduce a production when:

• You have permission to unproduce an exported production.

• The production is not running or pending.

To unlock and unproduce a production

1. From the Analysis & Review module, click the drop-down showing “All Documents” 
(default).

The folder window appears. 

2. Click the Productions folder to select the folder containing the production you want to 
unlock, then click the Edit icon and select Unlock/Unproduce from the Actions menu.

3. Confirm that you want to unproduce the folder and remove all production information.

4. If this production has been exported and is being stored on disk, delete the production 
export manually. 

Deleting the export prevents two documents branded with the same production numbers 
made available as exports.
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Performing Production Exports
Production export is run to generate images (PDF, TIFF format) for documents locked in a 
production folder, which can then be delivered to a requesting party.

After a production is created, you can export the production using the Export action.

To export a production

1. Select Production as the type of export. (For a complete list of Production Export options, 
refer to Table 3: “Production Export Selections” on page 26.)

2. Choose the production and the documents to export. Note that the platform will only 
export documents that have a produced version, even if you choose to export all 
documents.

3. Select how you want your document filenames to appear. 

4. If you select Production Number, then all documents (native, extracted text, and image) 
are named according to their production number. For natives, extracted text, and multi-
page TIFFS, the files are named according to the production number of the first page in the 
set. 

5. If you select Clearwell Document ID, then all documents (both native, extracted text, and 
image) are named according to their system Document ID. (Single-page TIFFs each have 
their own production number, and named by this number.)

The following apply to redacted documents and production exports: 

• If a document is redacted, it should not impact the metadata that is generated in the EDRM 
XML file.

• If a document is redacted, however, no native copies of the redacted file are exported.

• When doing a production export, The system includes the starting and ending page 
numbers for each document in the EDRM XML #StartPage and #EndPage metadata tags. 
The Start and End page numbers, as well as attachment start/end identifiers are available in 
the configurable templates as BegDoc/EndDoc and BegAttach/EndAttach. For more 
information, see “Using Load File Export Templates” on page 36.
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Export and Production GuideReporting
The Veritas eDiscovery Platform provides reports that include metadata and analysis from 
Export and Production. These reports can help identify content, location and other valuable 
metadata information. The reports are saved in comma separated values (CSV) and in Excel 
Worksheet (XLSX) files. For easy sorting, analysis and summarizing, you may prefer to view the 
CSV reports in Microsoft Excel. 

Refer to the following topics in this section:

• “Production” in the next section

– “Production Membership Report” in the next section

– “Understanding the Production Membership Report” on page 90

– “To create Production Membership report:” on page 90

• “Export” on page 91

– “Export Audit” on page 91

– “Understanding the Export Audit Report” on page 91

– “Comparing counts” on page 92

• “Logs” on page 93

– “Privilege Log” on page 93

– “Redaction Log” on page 94

– “Error log” on page 95

– “Generating Privilege and Redaction Logs” on page 95
› “Recommended workflow for Privilege and Redaction logs” on page 96

Production

Production Membership Report

The Production Membership report is useful for tracing and mapping a document to all the 
export production folders that it belongs to — this mapping may be especially valuable for 
validation and audit purposes for data that must adhere to strict regulatory or case 
requirements. The document-to-production folder mapping is achieved with column headings 
of the production folders and row entries for each of the documents. The tabular layout allows 
you to quickly see which documents are present in which production folders. 
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Understanding the Production Membership Report

The Production Membership report is saved as a CSV file. The report is a standard report 
template with pre-defined columns. You generate the report by using the PRINT CSV option. For 
PRINT CSV, the resulting CSV file contains information about the top level document and also all 
children items for a given document family. It will also print the Document ID for items, which 
are part of any and all locked and produced production folder.

To create Production Membership report:

Note:  It is assumed that you have already created production folders and populated them with 
documents. 

1. From the Analysis & Review menu, search and select the documents that you would like to 
track.

2. Select Print from the Actions drop-down menu.

3. From the Print menu, make selections and be sure to choose Document log (CSV) under 
the Format: subsection.

Note:   For a different format, you can select Full text (PDF).

Once you click “Print”, a job starts. You can monitor this from the Jobs window. When 
ready, you can click to view the report in CSV format or open it from Excel.

4. Analyze and view the results. 

A column for each production folder with a “YES” or” No” value makes it easy to determine 
if the document belongs to the production folder or not. 

In this example, Document ID 0.7.14.7153 is in two production folders: TestFolder1 and 
TestFolder2. The document is not in production TestFolder3.

Note:   In order to highlight the document-to-production folder mapping, not all of the 
report columns are shown.
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Export

Export Audit

Export audit reports summarize the export options and provide detailed statistics on the export 
including successfully exported and failed documents. It is a good idea to check the audit 
reports for errors after your export job completes. You can view export count information for 
Metadata, Production, and Print to PDF/CSV jobs. The reports are in a common format (XLSX) 
and, in the case of Metadata and Production, facilitate cross-checking and correlation of actual 
export item counts with Search result counts. 

Note:  The export audit reports provide an informative and easy-to-read series of worksheets 
that complement the existing XML summary file (summary.xml). For more information on the 
XML summary file, see “XML Summary Files” on page 58.

Standard audit report is available for the following exports: 

• Metadata (Export Summary, and Export Options worksheets)

• Production (Export Summary, Export Options, and Failed Images worksheets)

• Print to PDF/CSV Jobs (Export Summary, and Export Options worksheets)

Note:  The export audit report is not available for native only exports.

Understanding the Export Audit Report

An Export Audit Report is divided into Export Summary and Export Option worksheets. The 
Export Audit Production report contains an additional worksheet with Failed Images 
information. These worksheets are in a standard report template with pre-defined columns.

To view the explanation of a column, hover over the column heading until the info-bubble text 
appears. 

Export Summary Worksheet

The Export Summary contains sections and fields that organize, categorize and summarize 
export results. The counts vary according to the type of export. The reports range in complexity 
from detailed counts of success and errors from Metadata and Production exports to more basic 
export result data for Print to PDF/CSV jobs.

Export Options Worksheet

A list all of the selected export options for Metadata, Production and Print to PDF/CSV jobs. The 
production Export Options worksheet can be compared with the options listed in the XML 
summary file.

Failed Images Worksheet (Production Export only)

A list of the documents that failed imaging during production export. It contains the following 
fields: Document ID, Starting and Ending Bates Number and Slip Sheets. 
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Note:  This worksheet is blank if none of the documents failed imaging.

Top Level Error Worksheet

A list of the top level documents that failed to be exported and the reason for the failure.

Item Level Error Worksheet

A list of any errors associated with an item and includes a searchable DOCID. Errors in this item 
level category are not the type that would cause an entire document family to fail (such as an 
error with text extraction or metadata extraction).

Comparing counts 

By comparing actual export counts contained in the Export Summary page of the Metadata 
audit report with those in the Search Report, you can quickly verify or note discrepancies. It is a 
good way to check on the tallies between the two ways of counting results in the Search Report 
and the Export Audit Report.

Sample Comparison View of Search and Export Audit Report Metadata Counts
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Logs
Release 9.1 contains new reports where you can export an Excel-based metadata report of each 
item withheld or redacted in a production folder with the reason for withheld or redaction. You 
can select the production folder(s) and tags you wish to include in the Privilege/Redaction logs. 
You can also export tag values and tag-specific comments. However, you cannot export the 
complete tag hierarchy, item notes, and tag event comments.

Note that the Privilege/Redaction logs are different than the Production Membership report 
(Document log). The Document log contains information about the top level document and all 
the children items for a given document family, whereas the Privilege/Redaction log is an item-
level report.

Privilege Log

In a business requirement where you need to withhold data from the disclosure due to 
privileges, you might need to provide a log of all documents you are not disclosing and the 
reason for withholding information. Privilege log provides information on documents that are 
withheld in the a locked production folder. 
You can generate the Privilege logs for all types of productions (Native/Image/Mixed mode).

Fields included in the Privilege log report:

– Emails: From, To, Cc, Bcc, Subject, Date Sent, and Has Attachments

– Loose Files: Filename and Date Modified

– Document type

– Beginning Bates Number

– Ending Bates Number

– Has Redactions

– Slip-Sheet Reason

– Reason for withholding (a comma-separated list of all tag values applied to the item)

– Description of why Privilege/Exemption applied (List of Tag-specific comments 
associated with the tags applied on the item)

Example of a Privilege log:
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Redaction Log

In case you have applied redactions to the data to be disclosed, you might need to provide a log 
of all documents that contain redaction, and the reasons for those redaction.

Note:  Redaction log describes only those items that contain redactions and/or annotations 
within a locked production folder of type Images and Mixed only. Items that are neither 
redacted nor annotated are marked as skipped. The items which are only annotated and not 
redacted are included in the Redaction log with the Redacted page count as zero (0).

Redaction log can be generated on the Image and Mixed mode productions only.

Meta-data fields included in Redaction logs:

– Emails: From, To, Cc, Bcc, Subject, Date Sent, and Has Attachments

– Loose Files: Filename and Date Modified

– Document type

– Beginning Bates Number

– Ending Bates Number

– Reason for withholding (a comma-separated list of all tag values applied to the item)

– Redaction Reasons

– Redacted Page Count

– Description of why Privilege/Exemption applied (List of Tag-specific comments 
associated with the tags applied on the item)

Example of a Redaction log:
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Error log

In addition to the Privilege and Redaction logs, an Error report is also generated to list the 
following:

• Errored Items: the items which failed to extract all information.
If an item is part of multiple production folders and if the Privilege/Redaction log fails to 
extract the metadata of this item for any one of the folders, then this item will be listed in 
the Errored Items list. The item will not be partially listed in Privilege/Redaction log report 
at all..

• Skipped Items: the items that are skipped during export

Generating Privilege and Redaction Logs

Before you generate Privilege and Redaction logs, consider the following:

• The production folders must be locked before you start the Privilege/Redaction log job. 
Production Folders cannot be unlocked while the Privilege/Redaction logs job is in 
progress.

• By default, you can select a maximum of five production folders. You can increase this limit 
on number of production folders by setting the “esa.prlog.max.production.folder.count” 
property using System > Support Features > Property Browser.

• The Privilege/Redaction logs are item-level reports. The log will include one row for each 
item. If an item is part of multiple production folders, then a separate row for that item for 
each production folder gets added in the log.

• For each item, a maximum of 50 recipients can be included in each of the To, CC, and Bcc 
columns. If you wish to get more recipients in such items, you should contact Veritas 
Customer Support.

• A single Privilege/Redaction log report can have a maximum of 5,00,000 rows. When 
number of rows in a single report exceeds 5,00,000, the log file is rolled over and a new 
report gets generated for each set of 5,00,000 rows.
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Recommended workflow for Privilege and Redaction logs

Privilege Logs:

1. Identify the privileged items (to be withheld completely from the disclosure) and copy 
them to a new production folder, say “Privileged” with the production type as “Native”.

2. Lock the “Privileged” production folder. See the steps outlined in “Running a Production” on 
page 84.

3. Search for all items in the “Privileged” production folder.

4. Select the “Privileged” production folder on the Privilege Log UI and then submit a Privilege 
logs job on all the items in the search results. See the steps outlined in “To generate Privilege 
and Redaction logs:” in the next section.

Redaction Logs:

1. Identify the partially redacted items and copy them to a new production folder, say 
“Partially Redacted” with the production type as “Mixed”.

2. Lock the “Partially Redacted” production folder. See the steps outlined in “Running a 
Production” on page 84.

3. Search for all items in the “Partially Redacted” production folder.

4. Select the “Partially Redacted” production folder on the Redaction Log UI and then submit 
a Redaction logs job on all the items in the search results. See the steps outlined in “To 
generate Privilege and Redaction logs:” in the next section.

To generate Privilege and Redaction logs:

1. Submit a search to find the documents you want to export (as described in "Performing 
Searches" in the Veritas eDiscovery Platform User’s Guide). 

2. On any screen that shows a list of documents, click Actions and select Export.
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3. The export options window appears. Click the Logs tab.

4. From the Log to Export drop-down menu, select the type of log you wish to generate. You 
can select either Privilege Log or Redaction Log.

5. Click the Select Production Folder(s) tab and then select the production folders you wish 
to include in your log. Move these selected folders to the Selected Folder(s) & Tags list.

6. Click the Select Tag(s) tab and then select the tags you wish to include in the log. 
Move these selected tags to the Selected Folder(s) & Tags list.

7. Select the items from the items list to include in the log (if you wish to generate the log only 
for selected items).

8. Click Export Selected Items (to generate the log for selected items) or Export All Items (to 
generate the log for all items).

9. View report results in the Jobs window. In the Actions column, click the link to download 
the report.
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Export and Production GuideTroubleshooting Exports and Productions
This section describes the techniques you may want to use to troubleshoot failed or export and 
production jobs with errors. 

• “Troubleshooting Export Issues” in the next section

• “Troubleshooting Production Issues” on page 102

Troubleshooting Export Issues
Although rare, document exports from the Veritas eDiscovery Platform may not always 
complete successfully. This section provides the following troubleshooting tips and techniques 
to investigate and correct issues related to document exports.

If you need further assistance after attempting all applicable troubleshooting methods in this 
section, see “Technical Support” on page 8.

Diagnose a Failed Export

If your export job completed unsuccessfully, you have a few options: (1) Diagnose the failure by 
examining failed documents, or (2) Re-run the export job using slip sheets. 

Examine Failed Documents

The system provides a filter that contains all documents which did not successfully export, 
identified by the problem causing the failure. When you click a link from the Jobs window, the 
Export Errors filter appears in the Filter list, displaying the errors by type. This allows you to 
address the issues before re-running the production.
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To view failed documents

1. When your export job finishes, in the Jobs window, click the Find failed docs link to view 
the Export Errors filter. 

2. Apply your filters, then from Advanced Search, click Run Search. 

3. When your search results return, click View to open the problem documents. 

A. If the document content displays properly, the platform has connectivity to the source 
case files. A Retry of the export job should work.

B. If a “Content source is offline or unreachable” message displays, the 
system cannot retrieve the document. Look at the document locators to determine 
what type of document it is and where the sources are located.

– Loose files
Verify that you can access the document from its source location.  If the document is 
there, check permissions and confirm that you have access to the file.
Check the server.log under the System > Logs > View Logs tab for error messages 
surrounding the file(s) being retrieved.
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› Documents from a PST file
Warning: Before continuing, verify that you are NOT accessing the source location 
from any other window (for example, Explorer). Then, try restarting the 
EsaPstRetrieverService on the appliance. After the restart, re-run the search 
and see if the document is retrievable.

› Documents from an NSF file
Warning: Before continuing, verify that you are NOT accessing the source location 
from any other window (for example, Explorer). Then, try restarting the 
EsaNsfRetrieverService on the appliance. After the restart, re-run the search 
and see if the document is retrievable.



 PAGE: 102

Troubleshooting Production Issues
Use the following troubleshooting tips and techniques to investigate and correct issues related 
to production:

• “How the Platform Uses Slip Sheets” in the next section

• “Viewing Production Slip Sheet Reports” on page 102

– “Viewing Production Slip Sheet Reasons in Filter Search Results” on page 104

– “Add Slip sheet to a Production Export” on page 104

If you need further assistance after attempting all applicable troubleshooting methods in this 
section, see “Technical Support” on page 8.

How the Platform Uses Slip Sheets

The platform inserts “slip sheets” or identifier pages as placeholders during production for 
single page or multi-page documents that failed to image. Putting a slip sheet in place of a 
production exception helps avoid conversion failures that may occur when an export job is 
running. 

Slip sheets are also inserted for image files (TIFF or PDF) at the time of export. If any document 
fails to convert to TIFF or PDF upon export, a single .tiff or .pdf file is automatically inserted as a 
slip sheet representing all the bates numbers (numeric identifiers) in that document. Preserving 
this numeric continuity not only helps safeguard these image file types against export failure, 
but helps to accurately identify the failed document(s) for further troubleshooting and 
diagnosis, if necessary.

Viewing Production Slip Sheet Reports

As a best practice, Veritas recommends reviewing Production slip sheet reports to identify 
withheld or problematic documents during a production job. The report columns contain useful 
information and also contain a searchable DocID for tracking purposes. You can view the slip 
sheet report from the Analysis & Review module. 
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To view production slip sheet report

1. From the Analysis & Review module, click the drop-down showing “All Documents” 
(default).

Or

From the Analysis & Review module, select the Folders tab. 

2. Select the Productions folder, then click Edit from the Actions menu. The Production 
Folder menu displays.

3. On the bottom line of the menu, click the slip sheet report icon  to launch creation of 
the report (zip file).

4. From the jobs window, select the report zip file to download and review.

A brief description of slip sheet error types is provided below:

Table 9:  Slip Sheet Exceptions

Errors Description

EXCEEDS USER-SET LIMITS A production folder can be created with certain parameters (page count, 
timeout, size). This category distinguishes items where a slip sheet was 
created instead of an image due to user-specified criteria.

EXTERNAL The file is a type which cannot be imaged by IGC but can possibly be 
imaged by another piece of software and imported in, such as Microsoft 
One Note.

FULLY REDACTED This item was fully redacted. The slip sheet is expected.

INVALID The file is a type which cannot be imaged, such as an executable (EXE).

ZERO BYTES The file is zero bytes and has no data to be imaged. A slip sheet is 
automatically generated. 

Failed to Image Errors Description

FATAL There is a problem with IGC and it is likely that all imaging will fail.

INDEXER A problem with this document was discovered at the time it was indexed, 
and it cannot be produced.

NO IMAGE This item has failed to image but does not fall under any of the other 
categories of non-imageable files. This may be because there is a problem 
with the document, or perhaps the document is a type that cannot be 
imaged. 

TIMEOUT The file took longer than expected to convert and has timed out. Retry the 
export and the issue may resolve itself. 

RETRIEVAL The system failed to retrieve the file. This may be an intermittent error, in 
which case you should attempt to retry the conversion, or it may be a more 
permanent error, in which case you will have to troubleshoot retrieval.
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Viewing Production Slip Sheet Reasons in Filter Search Results 

Production slip sheet failures are also viewable in the Filter Search Results pane under the 
Review and Analysis module. To see the production slip sheet filter options, run the search on a 
production folder. 

To view production slip sheet reasons in filter search results

1. From the Analysis & Review module, select the production folder to review from the 
Folder menu. 

2. Click Go.

3. The produced documents display in List view with their production number displayed.

4. The filter search results include production slip sheet failures which are sorted into various 
error categories (a few of these failures are displayed below).

Add Slip sheet to a Production Export

You can create a production folder that contains slip sheets with the property browser. 

To export slip sheets

1. Go to System > Support Features, and select Property Browser.

2. Enter the name of the property: property esa.production.exportSlipsheetMode

3. Set the value to true. 

4. Click Submit to save your setting.

5. Select Lock/Produce to lock the folder and run the production.

6. After production completes, select Action > Export and select the Production tab.

Make sure you select the right production.

7. Select a template. Select the other options (if desired/required), then export the production
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For any email, attachment, or loose file that has had slip sheets applied during a production, the 
export EDRM XML file will contain a tag named “Slipsheet” to indicate that one has been 
applied. This information can be used in transforms as needed.
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User GuideAppendix A: Deprecated and Removed Features

Deprecation List

Table 1:  Deprecated and Removed Features

Release 
Version Deprecated Feature Recommended Migration

7.1.3 Apply Production Premediation

If you anticipate a lengthy, or potential error-
prone production due to certain document 
types and attachments which tend to cause 
errors, you can apply the “Production Pre-
mediation” support feature to help address 
these issues during production. 

Replaced with Image Remediation 
feature which is more comprehensive 
and better integrated with the product. 
For image tag and other feature details, 
see "Image Remediation" in the Case 
Administration Guide.
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Export and Production GuideAppendix F: Product Documentation
The table below lists the administrator and end-user documentation that is available for the 
Veritas eDiscovery Platform product.

Veritas eDiscovery Platform Documentation

Document Comments

Installation and Configuration

Installation Guide Describes prerequisites, and how to perform a full install of the Veritas eDis-
covery Platform application

Upgrade Overview Guide Provides critical upgrade information, by version, useful prior to upgrading 
an appliance to the current product release

Upgrade Guide Describes prerequisites and upgrade information for the current customers 
with a previous version of the software application

Utility Node Guide For customers using utility nodes, describes how to install and configure 
appliances as utility nodes for use with an existing software setup

Native Viewer Installation 
Guide

Describes how to install and configure the Brava Client for native document 
rendering and redaction for use during analysis and review

Distributed Architecture 
Deployment Guide

Provides installation and configuration information for the Review and Pro-
cessing Scalability feature in a distributed architecture deployment

Getting Started

Navigation Reference Card Provides a mapping of review changes from 8.x compared to 7.x and the 
user interface changes from 7.x compared to 6.x

Administrator’s QuickStart 
Guide

Describes basic appliance and case configuration

Reviewer’s QuickStart Guide A reviewer's reference to using the Analysis & Review module

Tagging Reference Card Describes how tag sets and filter type impact filter counts

User and Administration

Legal Hold User Guide Describes how to set up and configure appliance for Legal Holds, and use 
the Legal Hold module as an administrator

Identification and Collection 
Guide

Describes how to prepare and collect data for processing, using the 
Identification and Collection module

Case Administration Guide Describes case setup, processing, and management, plus pre-processing 
navigation, tips, and recommendations. Includes processing exceptions 
reference and associated reports, plus file handling information for 
multiple languages, and supported file types and file type mapping

System Administration Guide Includes system backup, restore, and support features, configuration, and 
anti-virus scanning guidelines for use with Veritas eDiscovery Platform

Load File Import Guide Describes how to import load file sources into Veritas eDiscovery Platform

User Guide Describes how to perform searches, analysis, and review, including detailed 
information and syntax examples for performing advanced searches
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Export and Production Guide Describes how to use and produce exports, productions, and logs (privilege 
and redaction logs) 

Transparent Predictive Coding 
User Guide

Describes how to use the Transparent Predictive Coding feature to train the 
system to predict results from control data and tag settings

Audio Search Guide Describes how to use the Audio Search feature to process, analyze, search 
and export search media content

Reference and Support

Audio Processing A quick reference card for processing multimedia sources

Audio Search A quick reference card for performing multimedia search tasks

Legal Hold A quick reference card of how to create and manage holds and notifications

Collection A quick reference card of how to collect data

OnSite Collection A quick reference for performing OnSite collection tasks

Review and Redaction Reviewer's reference card of all redaction functions

Keyboard Shortcuts A quick reference card listing all supported shortcuts

Production Administrator's reference card for production exports

User Rights Management A quick reference card for managing user accounts

Online Help

Includes all the above documentation (excluding Installation and Configuration) to enable search across all 
topics. To access this information from within the user interface, click Help.

Release 

Release Notes Provides latest updated information specific to the current product release

Veritas eDiscovery Platform Documentation

Document Comments
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